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About This Manual

Welcome to the programming system for
the Tait Orca series of trunked handport-
able and mobile radios. The program-
ming system provides an easy way to
enter settings and features into Tait Orca
trunked handportable and mobile radios
using a standard IBM-compatible PC.

This manualis intended as an installation
guide and reference for the Tait Orca pro-
gramming system. It provides the follow-
ing information:

B anoverview of the software;

W installation instructions and hard-
ware setup;

W basic usage instructions; and

W areference guide to all parameters
and settings.

Who Should Read This Manual?
This manual has been written for use by
Tait dealers and distributors who are pro-
gramming the Tait Orca series of trunked
radios for customers. Other audjences in-
clude radio system managers and net-
work managers who may need to know
the specific settings available for Tait
Orca series trunked radios.

What Do You Need to Know?

You should be familiar with:
B MPT trunked radio systems;

W radio system and radio network set-
tings and parameters; and

W general PC operation.
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Much of the information programmed
into the radio will depend on the network
the radio will be operating on. The net-
work operator, therefore, should provide
many of the parameters required to pro-
gram the radio.

MPT Standards

Tait Orca trunked radios are compliant
with MPT 1327/1343. For more informa-
tion on these standards, see:

W MPT 1327 A Signalling Standard for
Trunked Private Land Mobile Radio
System, January 1988, revised and re-
printed November 1991

W MPT 1343 Performance Specification,
January 1988, revised and reprinted
November 1991.

What's Included?

This manual is divided into eight parts.

Part 1, Getting Started, contains informa-
tion on installing and starting the pro-
gramming system.

Part 2, Using the Programming System,
contains information on navigating
through the programming system.

Parts 3 to 8 contain information on
changing settings using the screens in the
Edit menu.

Part 3, Before Changing Settings, contains
information you should read before
changing settings using the screens in the
Edit menu.



Part 4, Changing Network Settings, con-
tains detailed information on changing
network settings.

Part 5, Changing Fleet Settings, contains
detailed information on changing fleet
settings.

Part 6, Basic Radio Settings, contains de-
tailed information on changing general
information about the radio.

Part 7, Special Features, contains detailed
information on settingup special features
such as DTMF and conventional chan-
nels.

Part 8, Radio Interface Options, contains
detailed information on setting radio in-
terface options, such as function key set-
tings and user menu options.

What Radios Does this Manual
Apply to?

This manual applies to the Tait Orca se-

ries of handportable and mobile trunked
radios.

Throughout this manual, the radios in
the Tait Orca series are referred to by an
abbreviated version of their model name.
For example, the Orca Elan handportable
radio is referred to as the Elan handport-
able radio.

Where an option or setting only applies
to a particular radio, this is stated (see
“When an option or setting does not ap-
ply to all radios” below). Unless so stated,
an option or setting applies to all radios.

For information on the operation of a
particular radio, refer to the User’s Manu-
al for that radio.

Conventions
Throughout this guide, the following
conventions are used:

W screen names, field names, screen
buttons and computer keys are
shown in bold sans serif;

B commands you must type are shown
in sans serif;

W information you must provide is
shown <in brackets>;

W specific entries and available settings
for screen fields are shown ‘in single
quotes’; and

B names of computer directories and
files are shown in SANS SERIF ALL-
CAPS.

These conventions are illustrated in “Ty-
pographical conventions used in this
manual” on page 7.

When an option or setting does not apply to all radios

o —

These fields apply only to Excel and Eclipse

radios.

The fields in question do not apply to:
H Elan handportable radios and

Hl Elan mobile radios,

but do apply to all other radios.

NV — e —

These fields do not apply to Elan handportable

radios and to Elan and Excel mobile radios.

The fields in question do not apply to:
W Elan handportable radios;

B Elan mobile radios; and

I Excel mobile radios.
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Typographical conventions used in this manual

Pwr Lvl is the name
of the field

The field Pwr Lvi sets the transmit power level.
Select ‘H’,"M’, ‘L’ or ‘O’ for high, medium, low or

‘H', ‘M, ‘L’ and ‘O’ are the values
Pwr Lvl can be set to.

Insert the supplied disk in the floppy drive and at
the DOS prompt, type a:install (if the disk is in
drive A) or b:install (if the disk is in drive B. Press

Enter.

binstall is the command
to type in.

Press the Enter key to
initiate the command.

To start the programming system, type
c:\<pathname>\orcatrke, then press Enter.

Press the Enter key to
initiate the command.

Type in the command
c¢:\<pathname>\orcatrke
substituting the directory in
which the programming system
was installed for <pathname>.

ORCA.ICO is the
name of a file.

Select the file ORCA.ICO, then select Open.

Open is the name of
a screen button.
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PART

Getting Started

This part describes the system requirements and instal-
lation of the programming system. It also describes how
to connect a radio and what to do should you have prob-
lems with low memory.






Components and System Requirements

The Tait Orca programming system for
trunked radios allows you to tailor a radio
to your customer’s requirements and to
maintaina record of settings. You can use
this record to program other radios in the
fleet with the same settings.

The programming system has a standard
graphical user interface and can be used
with a keyboard and/or a mouse. Con-
text-sensitive help is available through-
out the program.

Your programming kit will typically con-
tain:

W a3.5-inch high density 1.44 MB pro-
gram install disk;

W aradio programming cable with a
25-pin serial connector at one end
and a telephone-style plug at the oth-
er;

W aradio programming lead with a tel-
ephone-style socket at one end and
an accessory connector at the other;
and

W this manual.

The Tait Orca programming system re-
quires a minimum of:

W anIBM compatible PC with an
80386 microprocessor (or better);

B MS-DOS version 5.0 or higher;
H 4MBofRAM;
B a VGA colour graphics display;
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a hard disk drive with 2 MB free
space; and

asingle 3.5 inch floppy disk drive
(1.44 MB capacity);

aprinter (if youintend tokeep a hard
copy of radio settings); and

a Microsoft or compatible mouse
and driver (if you wish to use the pro-
gram with a mouse).



Installing the Software

The Tait Orca programming system can-
not be run directly from the distribution
disk, and so must be installed on your
hard disk.

Insert the supplied disk in the floppy
drive. If installing the programming sys-
tem from DOS:

W At the DOS prompt, type a:install Gif
the disk is in drive A) or b:install (if
the disk is in drive B).

I Press Enter.

Ifinstalling the programming system
from Windows 3.x or Windows 95:

W Locate the directory the program-
ming system installer is in (drive A or
B).

Bl Double-click on the file
INSTALL.EXE.

The installation program will guide you
through the installation process. Read
the information presented on the screen
carefully. After installing the software,
place the original distribution disk in a
safe place.

You will be asked to enter the drive and
path to which you want the software in-
stalled. If you do not change the default
directory, then the files will be placed in

the \TAITORCA\TRK directory on the tar-

get drive. it is highly recommended you

use the default directory setting, especial-

ly if you have already installed or intend
to install other Tait software packages.

To use this program with a mouse, your
mouse driver software must be loaded.
Usually a command such as
¢:\<pathname>\mouse.exe can be added
to your AUTOEXEC.BAT file to load the
mouse driver automatically when your
computer starts up. See the instruction
manual for your mouse software for more
details.

Ifamouse is connected to a serial port on
your computer, you must have a second
serial port available to connect to the ra-
dio you wish to read or program. You can
select which serial port is used to commu-
nicate with the radio in the Defaults win-
dow (Utility menu).
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Connecting a Radio

The programming kit contains a radio
programming lead and a radio program-
ming cable for connecting the radio being
programmed to the computer.

B The programming cable has a 25-pin
serial connector at one end and a tel-
ephone-style plug at the other.

B The programming lead has a tele-
phone-style socket at one end and a
handportable radio accessory con-
nector at the other.

Your radio should be turned off before
you connect it to the computer.

W For mobile radios, connect the pro-
gramming cable to the radio using
the telephone-style plug and to the
computer’s serial port using the seri-
al connector. The programming lead
is not required.

W Forhandportable radios, connect the
programming cable to the program-
ming lead, then connect the accesso-
1y connector to the radio and the
serial connector to the computer’s se-
rial port.

You can plug the serial connector into ei-
ther the COM1 or COM2 port on your
computer. If you select COM1, you must
change the software configuration in the
Defaults window (Utility menu). For
more information on setting up your
COM ports, see “Customising Your Sys-
tem” on page 25.
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The serial connector is 25-pin; if your
computer has a 9-pin serial port, you will
need an adaptor cable. This is available
from your PC dealer.

Once connected, the radio must be
turned on before it can be programmed.
The battery should be fully charged or a
DC service adaptor used to ensure that
the radio does not turn itself off during
the programming session.



Starting the Programming System

The programming system can be run
from DOS, from Windows 3.x or from
Windows 95.

To start the programming system from
DOS, change to the directory the pro-
gramming system was installed in, type
orcatrke, then press Enter.

To start the programming system from
Windows 3.x, either:

B Double-click the programming sys-
tem icon.

OR

MW In Program Manager, choose Run
from the File menu. Type
c:\<pathname>\orcatrke, then press
Enter.

To start the programming system from
Windows 95, either:

B Double-click the programming sys-
tem icon.

OR

B Choose Start from the taskbar.
Choose Run and type
c:\<pathname>\orcatrke, then press
Enter.

About Passwords

When you start the programming sys-
tem, you will be asked to enter a pass-
word. The password you enter
determines the screens and fields you will
be able to edit.

It is recommended that you use the low-
est level of password access necessary to
edit the fields you wish to change. This
helps to ensure that you do not acciden-
tally change other data.

The password and access levels are as fol-
lows:

W Low level access. No password is re-
quired, simply press Enter. This level
allows you to change selected radio
and fleet data. You will not be able to
edit network data.

W Medium level access. This level al-
lows you to change all radio and fleet
data. You will not be able to edit net-
work data.

W High level access. This level allows
you to change all unit, fleet and net-
work data.

When you do not have access to a field,
you can view it, but you cannot select the
field or change its value. If you do not
have access to all fields in a particular
screen, the option to select that screen
from the Edit menu will not be available.

Memory Problems

Ifyou get a low memory message the first
time you start the programming system,
quit the programming system and:

B runamemory optimising utility; or
W remove unnecessary drivers; or

M remove unnecessary terminate-stay-
resident programs.
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Consult your DOS manual for farther in-
structions.

If you are running the programming sys-
tem from DOS and are unable to make
more memoyy available, the program-
ming system will still run but you may en-
counter problems if you are setting up
complex systems.

If you are running the programming sys-
tem from Windows 3.x or Windows 95,

close other applications. If you still get a
low memory message, consider running

the programming system from DOS.
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PART

2

Using the Programming
System

This part describes the basic operation of the program-
ming system.






Basic Operations

This part describes the basic operation of
the Tait Orca programming system for
trunked handportable and mobile radi-
0s.

Navigating

The programming system can be used
with a mouse or a keyboard or both. To
navigate through the programming sys-

Table 1: Programming system keystrokes

tem using a mouse, simply place the ar-
row onto the menu option or option
button you wish to choose and click the
left mouse button once.

All functions can be selected from the
keyboard with the keystrokes outlined in
Table 1.

Key Function Key Function
F1 Online help for the current field. Alt-Left Scroll across a screen from right
Pressing the F1 key again arrow to left.
accesses general help.
F2 Insert a row into an array box. Ins Toggle insert/overtype mode. The
default is insert.
F3 Delete a row from an array box. Del Delete character to the right.
Alt Select the window menu bar. The Backspace Delete character to the left.
Alt key can be used in conjunction
with a hot key to select a specific
menu item. For example, press-
ing Alt, F, S brings up the ‘Save
File’ window.
Up arrow Scroll a vertical list up or move Enter End edit and validate new value.
vertically in a pop-up menu.
Down arrow Scroll a vertical list down or move Esc Close a window.
vertically in a pop-up menu.
Right arrow Move to the right along the menu Tab Move to next.
items in the menu bar.
Left arrow Move to the left along the menu Shift-Tab Move to previous.
items in the menu bar.
Alt-Right Scroll across a screen from left to
arrow right.
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Using Text Boxes
A text box appears as a simple box and
usually contains default text.

TAIT ORCA

Select the box using the Tab key or by
clicking on it with the mouse. A text cur-
sor will appear in the box and any default
text will be highlighted. Type in the data
and press Enter to set the new value.

Using Screen Buttons

A screen button appears as a boxand con-

tains a default setting, such as ‘City’ for
squelch level.

A screen button can toggle between two
or more values. Change the value by se-
lecting the button using the Tab key and
pressing Enter, or by clicking on it with
the mouse.

Screen buttons also appear on control
menus and dialog boxes and contain such
entries as OK and Cancel, in which case
only the option displayed is available.
Click on the button to activate the com-
mand, or select it with the Tab key and
press Enter.

Using List Boxes

A list box is used for fields that have a
range of possible values and appears as a
box with an arrow at the righthand side.

Drca Eclipse *

Orca Elan L+
Orca Excel ||
Orca Eclipse 1

20

Using the keyboard, select the desired val-
ue by using the Tab key to select the field,
then press Enter to open the drop-down

menu. Use the arrow keys to scroll to the

desired value, then press Enter.

Using the mouse, click on the arrow to the
right of the field to open the drop-down
menu, then click on the desired value.

Using Array Boxes

An array consists of lines of various data
entry fields, such as list boxes and text
boxes, as shown below.

B ]
& [ ]

[Full

|nrea

An array box is used where many lines of
data are required, each containing the
same type of information. When a line of
data entry fields shows only exclamation
marks, there is currently no data in the ar-
ray. Press the F2 key to insert a new line
for data entry. To delete a line from an ar-
ray, select any field on that line by using
the Tab key or the mouse and press the
F3 key.

The Main Window

The programming system main window
is shown on page 21. This is the window
that will appear when you first start the

programming system.

The box in the centre of the window
shows the version number of the soft-
ware, and the bar at the bottom of the
window shows the name of the file you
are working with. If you have just started
the program or have selected New from
the File menu, this will read ‘Untitled’.
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Main window

Eile | Radio Edit Utility

Help

Quit

Programning Software
for
Tait Orca Trunked Radios

Version 1.15

Copyright (c) Tait Electronics Ltd, 1999

[Untitled

The menu bar shows the title of six men-
us.

B Use the options in the File menu (Alt-
F) to create, save and load files.

B Use the options in the Radio menu
(AIt-R) to read and program a radio.

W Use the options in the Edit menu
(AR-E) to change programmable op-
tions.

W Use the options in the Utility menu
(Alt-U) to print radio settings and
modify some of the facilities in the
program.

W Use the options in the Help menu
(Alt-H) to get information on the pro-
gramming system.

B Use the Quit menu (Alt-Q) to exit the
programming system.

Select the keywords by clicking on them
with the mouse, or by holding the Alt key
and pressing the underlined letter (for ex-
ample: F for File). Once the menu bar is
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selected, you can select other options us-
ing the right and left arrow keys.

Whenever you finish working in a win-
dow, you will return to this main win-
dow. From the main window, you can
exit the programming system and return
to the DOS prompt or Windows.

Online Help
The programming system has two forms
of online help.

Pressing the F1 key displays online help
specific to the field selected when the key
is pressed. Pressing the F1 key again dis-
plays general help.

The Help menu gives you access to gener-
al navigation information and informa-
tion about the programming system.
Each of the screens in the Edit menu also
has a Help menu.

Throughout online help, radio keys are
referred to as outlined in Table 2. For in-
formation on key functions, refer to the
User’'s Manual for each radio.

21



Table 2: Radio keys and their online help
equivalents

Key Description | Help Reference
« Enter [ENTER]
: Despatcher [DESPATCHER]
\( Queue [QUEUE]
= DTMF [DTMF]
‘ or X Monitor/Clear [MON] or
[X-CLEAR]
S Status [STAT]
D Menu [MENU]
x Alpha [ALPH]

The File Menu

The options in the File menu allow you to
store and retrieve the options you pro-
gram into a particular radio so you can
keep a copy of a customer’s requirements
if you need to program more radios with
the same or similar settings. These files
are referred to throughout this manual as
radio settings files and may be stored on
hard disk or on a floppy disk.

All filenames are automatically given the
extension ‘.ops’ unless you specify anoth-
er extension. Filenames must be eight
characters or less in length.

22

Loading Radio Settings Files

The Load option retrieves a radio set-
tings file from a disk. When you choose
Load, the File window will appear. The
File window is shown on page 23). In it,
you can either specify the path and name
of the file you want to open (in the File
Name box) or search for the file using the
Drives, Directories and Files lists.

The Drives list shows all the drives asso-
ciated with your computer.

The Directories list shows all the directo-
ries immediately available on the selected
drive. When you select a directory, the
next level of directories appears. The pre-
vious level of directories is indicated by
the .. symbol.

The Files list shows all files in the current
directory with the properties shown in
the File Name box. The default is ‘.ops’
or the extension shown in the Data File
Extension field (Defaults window). Se-
lect the file you wish to open by clicking
on the filename displayed in the Files list,
or use Tab to select the file name and
then press Enter. Select OK to load the
file, then Exit to exit the window.

Saving Radio Settings Files

The Save option saves the current radio
settings file you are working on. If the file
has already been saved to disk, it will be
saved with the same filename, overwrit-
ing the original file. The Save As.. option
saves the current file under a new name.
The Save As.. option is useful if you wish
to use an existing radio settings file as a
template for other files.

When you choose Save or Save As.., the
Validation window will appear asking
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File window

File Hane: *.0ps

Directoru: c ntaitorcastrk

Drives: Directories: Files:

HEHa: [t = + +

=He: ]

Hd:

=i * *
0K | | Exit |

whether you wish to validate the file. You
should select Yes to avoid saving a file
that may cause a radio to malfunction as
aresult of illogical or impossible options.
It is especially important to run a final
validation check if you have not run vali-
dation after completing work in the
screens in the Edit menu.

Once validation is complete, the file will
be saved and a message to this effect will
appear in the bar at the bottom of the
main window.

If the file has not previously been saved,
the File window will appear and prompt
you to specify a path and name for the
file. The file will automatically be saved
with the “.ops’ extension unless you spec-
ify a different one. Enter the name of the
file in the File Name box, then select the
drive and directory where you wish to
save the file. Select OK to save the file.
When the file has been saved, a message
to this effect will appear in the bottom of
the File window. Select Exit to exit the
window.
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Creating a New Radio Settings File
The New option sets all fields in the
screens in the Edit menu to their default
values. If you have made changes to data
since starting the programming system,
you will be warned that you may lose da-
ta. If you do not wish to save your chang-
es, select OK. If you wish to save these
changes, select Cancel and save the data
using the Save or Save As.. commands.

The Radio Menu

The options in the Radio menu allow you
to program the radio with the operating
information you create in the program-
ming system. You can also retrieve infor-
mation from a radio so you can change it.

The Read option retrieves the current
settings from a radio so you can make
changes to it. When the Read option is
selected the Radio window (shown on
page 24) will appear with the message ‘Es-
tablishing Serial Link to Radio” in the bar
at the bottom of the window. The radio
information fields will remain blank until
the radio has been read. Select the Can-
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cel button if you wish to cancel reading
the radio. The Radio window will close
and you will return to the main window.

The Cancel button will change to read
Done once the radio has been read, and
the radio information fields will show the
‘Radio Type’, ‘Software Version’, ‘Data-
base Version” and ‘Dynamic Database
Partition’.

Once the radio has beenread, select Done
to exit the window.

The Program option programs the radio
with the operating information you creat-
ed in the programming system. When
you select Program, the Validation win-
dow will appear. Select Yes to run a final
validation of your settings. During valida-
tion, the programming system will cycle
through all the settings in the Edit menu
screens, and if no conflicts are found, the
Radio window will appear with the mes-
sage ‘Establishing Serial Link to Radio’.
Once the link is established, the radio will
be programmed. Select Done or Cancel
to exit the window.

Validation is important because it avoids
the problems that can occur with impos-

Radio window

sible or conflicting radio settings. If con-
flicts are found, the radio will not be
programmed; check your settings. If the
settings that conflict are acceptable, then
select No when asked if you want to vali-
date settings.

It is highly recommended that a full vali-
dation is done at least once after any
changes are made.

Problems Communicating with the
Radio

If you are having problems reading from
or programming the radio, check that:

W the correct serial port is specified in
the Defaults window (Utility menu);

W the radio programming cable is con-
nected to the correct serial port con-
nector;

W theradio programming cable/lead is
connected to the radio;

W the radio type matches the software
being used; and

W the radio is turned on.

Radio Type:
Software Uersion:
Database Uersion:

Dynamic Database Partition:

8z

Serial Port in use: 2

Cancel

1883

Establishina Serial Link to Radio...

24
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Ifyou still have problems reading from or
programming the radio and are running
the programming system from Windows,
check that only one copy of the program-
ming system is running and that no other
applications that use serial ports are run-
ning. Such applications may prevent ac-
cess to the port even if they are not
actively using it.

Make sure no other serial hardware de-
vice, such as a modem, is trying to use the
same COM port as the programming sys-
tem. In addition, another COM port can-
not be using the same interrupt at the
same time as the programming system.
For example, a mouse and the program-
ming system cannot be on COM ports
that share the same interrupt; however, a
modem and the programming system
can be on ports that share an interrupt if
the modem is not used while the pro-
gramming system is being used. Typical-
ly COM1 and COM3 use the same
interrupts, as do COM2 and COM4. If
you need to modify these settings, refer to
your DOS manual or online help.

Ifyou still have problems, refer to your
DOS manual for information on config-
uring hardware and troubleshooting seri-
al communications.

The Edit Menu

The options in the Edit menu allow you
to change radio settings. Parts 3 to 8 con-
tain detailed information on changing ra-
dio settings using the screens in the Edit
ment.
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The Utility Menu

The Utility menu contains three com-
mands for setting up the programming
system: Print, Colours and Defaults.

Printing Current Data

The Print option in the Utility menu al-
lows you to print all of the radio settings
you have stored. Printing cycles through
all of the Edit menu windows and sends
the settings to the default paralle] port.
The Print option also appears in individ-
ual screens, such as those in the Edit
menu, in which case only the options for
that screen will be printed.

Ifyou select Print but your printer will
not print, you may need to change the
Parallel Port and/or Printer Type set-
tings (Defaults option, Utility menu).

Customising Your System

The programming system lets you alter
certain settings to suit your computer set-
up and operations. These settings are the
screen appearance and colour and the file
and port defaults.

Changes are made using the options in
the Utility menu. The Colours option al-
lows you to change the overall appear-
ance of the screen, and the Defaults
option allows you to change port and file
location settings.

The Colours option in the Utility menu
allows you to change the display colours
of the programming system to suit your
preferences. When you select Colours,
the Screen Colour Manager will ap-
pear. The Screen Colour Manager win-
dow is shown on page 26. The Screen
Colour Manager includes a Sample
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Screen Colour Manager window

Print Help Palette Background

-|I Sample Hindow
| ClickHere | 0K |
[Selectable | [Non_ Selectable | | Click | | Cancel |

Orca Hobile E Orca Hobile

Orca Portable

Orca Conventional
Oeca Trunkad

:

Window that displays the current set-
tings.

Palette gives you a choice of colour com-
binations, and Background gives you a
choice of background colours. Choose
OK to apply your colour changes, Cancel
to restore the previous settings, or Exit to
exit the Screen Colour Manager.

The file location and extension can help
you organise your programming data.
The port locations are most important
because they determine the location of
your printer and the specific hardware

Defaults window

connection used in attaching a radio to
your system for programming. File and
port settings can be changed using the
Defaults option in the Utility menu. The
Defaults window is shown below.

Data File Path determines the default di-
rectory on your hard drive that will be
used for storing radio data files. The de-
fault is *./opsfiles’. The full stop repre-
sents the directory the programming
system is installed in.

Data File Extension determines the de-
fault filename extension for all data files.

Print  Help

Data File Path: [-~opsfiles

Data File Extension:
Serial Port:
Parallel Port:
Printer Type:

26
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Serial Port determines the hardware
connection to which all data for program-
ming radios will be sent. It can be either
COMI or COMZ. The default is COM2.If
your mouse or modem is using COM2,
you will need to change this setting.

Parallel Port determines where data to
be printed is sent. The default setting is
LPT1, but you can also select LPT2.

Printer Type sets the format that will be
used to send data to the printer. If your
printer is a Hewlett Packard printer or is
compatible with Hewlett Packard’s print-
er command language (PCL), select ‘HP’.
If not, select ‘Other’. Most laser printers
and inkjet printers and many dot matrix
printers are compatible with HP PCL,
and so ‘HP’ is the default. If the Parallel
Portsettingis correct and all connections
are working properly but you cannot
print, try setting Printer Type to ‘Other’.
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The Quit Menu

The Quit menu allows you to exit the pro-
gramming system. You will be asked to
confirm your selection. Click on Yes or
press Enter to return to the DOS prompt
or your operating system.
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PART

Before Changing Settings

This part contains general information on program-
ming Tait Orca trunked radios. You should read this
part before you start changing settings in the screens in
the Edit menu.






Programming Sequence

When programming a Tait Orca trunked
radio, you will find that possible entries
and availability of certain features some-
times depends upon settings in other
screens. The order in which screen data is
entered is, therefore, important.

The recommended order for changing ra-
dio settings is:

W network settings; then
W fleet settings; then
W radio unit settings.

Access to some programming informa-
tion is restricted by the password you en-
ter when you start the programming
system (see “About Passwords” on

page 14).

Inmany cases, you will be supplied with a
file that contains the correct network
and/or fleet settings and so will need to
change settings only for the particular ra-
dio being programmed. The supplied file
can be loaded using the Load option in
the File menu.

Network Settings

Although few users will need to alter net-
work information, it should be changed
first.

Edit menu screens that contain informa-
tion specific to a network are:

B Hunting Parameters
H Network Identity

B Network Parameters
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W Trunked Channel Blocks.

Once this information is correct or a suit-
able network file has been loaded from
disk, fleet settings should be changed.

Fleet Settings
Edit menu screens that contain informa-
tion specific to a fleet are:

Il Fleet Identity
H LMS - Fleet Identity
W Fleet Parameters.

Once this information is correct or a suit-
able file has been loaded from disk, unit
settings should be changed.

A file that contains suitable fleet settings
will also contain the correct network set-
tings.

Radio Unit Settings
Edit menu screens that contain informa-
tion specific to a radio unit are:

Specifications

Radio Unit Identity

LMS - Radio Unit Identity
Power Save Features
Acquisition Data

DTMF Parameters
Conventional Channels

5 Digit Interfleet Lookup Table

Preset Calls
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W Call Options
M Key Settings

W User Selectable Parameters.

Validation

As you exit each screen in the Edit menu
screens, you will be asked if you wish to
validate the settings. You should select
Yes to avoid attempting to program a ra-
dio with illogical or impossible options.

You also have the option of validating set-
tings immediately before programming a
radio (when you choose Program from
the Radio menu).

A full validation should be done at least
once after any changes settings are made.

32
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Changing Network Settings

PART

This part describes how to change network settings.

Some of the fields in these screens require only low- or
medium-level password access. However, for access to
all fields in these screens, you will need high-level pass-
word access.

The Edit menu screens discussed in this part are:
Bl Hunting Parameters

H Network Identity

H Network Parameters

H Trunked Channel Blocks






Hunting Parameters Screen

The fields in the Hunting Parameters
screen relate to network hunts carried out
by the radio. The Hunting Parameters
screen is shown below.

Time-Shared Channels

The field Nokia TS Channel Support
sets whether the radio supports Nokia
time-shared channels. Select ‘Enabled’ or
‘Disabled’.

When Nokia TS Channel Support is set
to ‘Enabled’, standard MPT 1343 hunt-
ing procedures are varied by recognising
Nokia Actionet time-shared control
channels and ignoring the preset L2 sig-
nal level while performing background
searches. Because the L2 signal level is ig-

Hunting Parameters screen

nored, a radio will always try to find a bet-
ter control channel regardless of the
signal strength of the current control
channel.

When Nokia TS Channel Support is set
to ‘Enabled’, the radio nolonger complies
with MPT 1343.

Background Searches

The background search sequence is a
method prescribed in MPT 1343 for
monitoring other control channels and
migrating to a supetior channel when one
is found.

The search is performed by periodically
leaving the current control channel and

Print Help

Nokia TS Channel Support
Backaround Search

Hunt Upon Expiry of NME or NR
Comprehensive Hunt

Act On Uote MNou

Vote Mow Advice Margin
Control Category

Site Select

Channel Display

Normal Hunt Channels

Channel Tupe
i | Cont inuous I

Disabled
Enabled

Preferential

Enabled

Disabled

15|
]

Disabled
Disabled

Non Applicable Channels

From To

[ 1
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sampling other control channels. What
channels are sampled is defined in the
Normal Hunt Channels array. If a chan-
nel is consistently found for a certain
number of consecutive samples to be pre-
ferred (according to the NDD preference
data defined in the Acquisition Data
screen) or stronger than the current con-
trol channel be a certain margin, the ra-
dio will perform a preferential sampled
hunt to acquire the new control channel.

Set the field Background Search Se-
quence to ‘Enabled’ to allow the radio to
carry out background searches.

The interval at which the radio performs
the search s defined by the parameter TL,
and the amount of time the radio spends
performing hunts is determined by the
parameter TH. The number of samples
taken of each candidate control channel
during the background search is deter-
mined by the parameter NS. These pa-
rameters are set in the Network
Parameters screen, together with three
other parameters related to background
searches, LM1, LM2 and LM3. See “Back-
ground Search Parameters” on page 43
for more information.

Acquiring a Control Channel
Upon Call Setup Failure

The field Hunt Upon Expiry of NE or NR
determines the type of control channel
hunt performed when an attempt to set
up a call is unsuccessful (when NE or NR
expire).

Select ‘Normal’, ‘Preferential’ or ‘Disa-
bled’.

H When Hunt Upon Expiry of NE or
NR s set to ‘Normal’, the radio will
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carry out a background search using
the information in the Normal Hunt
Channels array.

B When set to ‘Preferential’, the radio
will carry out a background search
using the NDD preference data (Ac-
quisition Data screen).

B When set to ‘Disabled’, no search
will be performed.

For the radio to be fully MPT 1343 com-
pliant, you should select ‘Disabled’, as
MPT 1343 requires that no hunt be per-
formed and the radio wait for further sig-
nalling when a call attempt fails.

On some networks, selecting ‘Normal’ or
‘Preferential’ may improve the chances of
successfully making the call on the next
attempt.

Failure to Find a Control
Channel

The field Comprehensive Hunt deter-
mines how the radio behaves when it fails
to find a control channel. If Comprehen-
sive Hunt is set to ‘Enabled’, the radio
will then search through all defined chan-
nels, except those specified as non-appli-
cable in the Non Applicable Channels
array.

Vote Now

Some trunking systems use a ‘vote now’
BCAST codeword to help the radio find
the best control channel. When the radio
receives a vote now BCAST codeword, the
radio will switch to the channel specified
by the system and monitor its RSSIlevel.
If the RSST on the new channel is not
greater than the current control channel
by the value set in the field Vote Now Ad-
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vice Margin, the radio will return to the
current control channel. Otherwise the
radio will switch to the control channel
specified by the trunking system.

Set Act On Vote Now to ‘Enabled’ to al-
low the radio to act on vote now BCAST
codewords.

The field Vote Now Advice Margin sets
the signal strength margin that the new
channel must exceed the current control
channel by for the radio to switch to the
new control channel it has been directed
to by a vote now BCAST codeword. Act
On Vote Now must be set to ‘Enabled’ for
the setting of Vote Now Advice Margin
to have any effect.

Set a value from 1 to 15 dB in steps of 1
dB.

Access Rights

The setting of the field Control Category
determines the radio’s rights of access to
a network’s control channels.

A radio can only access a control channel
when the radio’s Control Category cor-
responds to the value of the LAB field in
the system identity code.

Select one of the categories: A, B, Cor D.

Site Select
The Site Select feature is not available
for Elan handportable radios.

The Site Select feature allows a user to
dial a control channel the radio must
then attempt to register on regardless of
its suitability for acquisition.

If the field Site Select is set to ‘Enabled’,
a function key should be designated for
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the ‘Site Select’ option (Key Settings
screen).

Channel Display
The Channel Display feature is not avail-
able for Elan handportable radios.

The Channel Display feature allows the
user to view the current control channel.
If the radio is hunting then the user will
observe the control channel changing
rapidly. However, if there are other mes-
sages present on the display then the dis-
play of the control channel will take
lowest priority.

When Channel Display has been set to
‘Enabled’, the radio will also display the
traffic channel while it is engaged in a
call. Once the call has been cleared down,
the control channel will again be dis-
played.

Normal Hunt Channels Array
The Normal Hunt Channels array de-
fines the channels that will be examined
during a normal background search se-
quence to see if they can be acquired as a
control channel.

If the radio fails to find a suitable control
channel among these channels, it will
search through all channels if the field
Comprehensive Hunt is set to ‘Enabled’.

The channels available to the radio are
defined in the Trunked Channel Blocks
screen. See page 47 for more informa-
tion.

Up to 32 normal hunt channels can be de-
fined. Press F2 to insert a new channel, or
F3 to delete the current channel. At least
one channel must be defined, and so the
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last remaining channel cannot be delet-
ed.

Two fields must be set for this list: Chan-
nel and Type.

Channel

For the field Channel, enter any channel
number between the lowest and highest
channel defined for the network. See your
network operator for these values.

Type

For the field Type, select ‘Continuous’ or
‘Time-shared’. See your network opera-
tor for the channel type, which will nor-
mally be ‘Continuous’.

Non Applicable Channels Array
The Non Applicable Channels array de-
fines the upper and lower limits of the
channel range that will not be included in
comprehensive hunt sequences. Press F2
to insert a new range of channels, or F3 to
delete the current range.

You can define up to ten channel ranges,
where the field From defines the start of
the range not included in the hunt and
the field To defines the end of the range
not included in the hunt. See your net-
work operator for these values.

If the field Comprehensive Hunt is set to
‘Disabled’ or if you do not wish to limit
the range of channels the radio will
search, this list can be left blank.
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Network Identity Screen

Fields in the Network Identity screen set
properties of the network the radio will
be operating on.

Information in this screen cannot be al-
tered unless you have high level password
access. Appropriate values for the fields
in this screen will be assigned by the net-
work operator.

The Network Identity screen is shown
below.

Network Type and Identity
Together, the fields Network Type and
Network Identity Code determine
whether a control channelis considered a
candidate for acquisition. If the relevant

Network Identity screen

bits decoded from the control channel do
not correspond to the values pro-
grammed into the radio, the radio will
not consider that control channel a candi-
date.

The field Network Type sets the network
type, which can be either ‘National’ or
‘Regional’. Consult your network opera-
tor for the correct setting.

The field Network Identity Code sets the
network’s identity code. Enter the value
assigned by your network operator.

W Ifthe field Network Type is ‘Nation-
al’, this value will be from 0 to 3.

Print Help

HNetwork Tupe
Network Identity Code

SYNC Sequence

Area Field Length (LAY

Zone Field Length (LZ)

SIL Field Length C(LSIL)>

HNunmber of Pressel On  Messages (HPON)
Nunber of Pressel Off Messages (NPOFF?
Pre-Enphasis

Multiple Registration

Ualue of INFO in ROR

NatiDnalI

Q
&
L=}
]

HEEEE

Other
Enabled
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W IfNetwork Type is Regional’, this
value will be from 0 to 127.

If Network Type is ‘Regional’, you can as-
sign up to eight Network Identity Codes.
Press F2 to insert a new code or F3 to de-
lete the current code.

Syncronisation Sequence

The field SYNC Sequence sets the code-
word synchronisation sequence (SYNC)
for messages transmitted on the control
channel.

Enter the SYNC sequence code assigned
by your network operator, which will be
in hexadecimal format.

B MPT 1327 and Regionet 43 define
SYNC as C4D7.

W PAA2424 defines SYNC as B433.

Area, Zone and SIL Field
Length

The fields Area Field Length (LA), Zone
Field Length (LZ) and SIL Field Length
(LSIL) set parameters used in tests car-
ried out by the radio.

The values of the fields Area Field
Length (LA) and Zone Field Length (LZ)
are used to see if the radio can acquire a
control channel. The value of both fields
will depend on Network Type.

W In MPT 1327, if Network Type is
‘National’ the values of Area Field
Length (LA) and Zone Field Length
(LZ) will be from 0 to 9.

W IfNetwork Type is Regional’, the
values of Area Field Length (LA)
and Zone Field Length (LZ) will be
from 0 to 4.
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The value of the field SIL Field Length
(LSIL) is used to check whether a clear
down received is from the correct trunk-
ing system controller. It acts as a safe-
guard against a radio responding to
messages generated by other sites using
similar frequencies or received as a result
of intermodulation products.

Enter the values assigned by your net-
work operator.

Pressel On/Off Messages

While a speech call is in progress, a radio
will send pressel on messages (NPON)
when the PTT is pressed and pressel off
messages (NPOFF) when the PTT is re-
leased. These messages assist call mainte-
nance.

The fields Number of Pressel On Mes-
sages (NPON) and Number of Pressel
Off Messages (NPOFF) set how many of
these messages will be sent. Enter the val-
ue assigned by your network operator,
which will be from 1 to 5.

Pre-Emphasis

For the field Pre-Emphasis, select
‘French’ or ‘Other’. For PAA2424 net-
works, Pre-Emphasis should be set to
‘French’.

Multiple Registration

When the field Multiple Registration is
set to ‘Enabled’, the radio is able to store
up to three registration records and
thereby be simultaneously registered on
up to three control channels. It may then
roam between those control channels
and acquire any of them without re-regis-
tering.
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The oldest registration records expire
and are deleted after a period TD follow-
ing registration (which is set in the Net-
work Parameters screen). The most
recent record is known as the Prime
record and does not expire. The trunking
system announces how many registration
records (either 1, 2 or 3) a radio shall
maintain, via the BCAST SYSDEF 3 mes-
sage.

If Multiple Registration is set to ‘Disa-
bled’ only a single registration record is
maintained and any previous registration
record will be discarded when the radio
registers on a control channel.

INFO Field in Request to
Register Messages

The field Value of INFO in RQR sets the
15-bit value that is added to the INFO
field when a radio requests registration.

This is normally set to 0, but in some sys-
tems is customised to convey additional
information to the trunking system con-
troller (TSC). Consult your network oper-
ator.
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Network Parameters Screen

The fields in the Network Parameters
screen set variables used in communica-
tion with the trunking system control
channel. They can be divided into three
categories:

W control channel acquisition and re-
tention;

W background search sequence param-
eters; and

W miscellaneous signalling parametexs.

The Network Parameters screen is
shown below.

Network Parameters screen

Control Channel Acquisition
and Retention

The fields listed under Control Channel
Acquisition/Retention set parameters
the radio uses when attempting to ac-
quire and retain a control channel.

The same values of parameters NZ1 and
NZ2 apply to both continuous and time-
shared channels. Parameter TS applies
only to time-shared channels.

Different values of parameters NC1,
NC2, NV, NX1 and NX2 can be set for
continuous and time-shared channels.

Your network operator will tell you what
value to set these fields to.

Print Help

Control Channel Aquisition/Retention
NZ1
NZ2

il

TS sec
Continuous Time-shared
NC1

nez

i
[0

Mz

Background Search Sequence Paraneters

@
un
n
n

TL

n

HHHNGEE

TH slots

NS

4 4 a
oD om

Signalling Parameters
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ND1
ND2

=
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A

NE
NR
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D
TJ
™
TT
TA sec
B
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TH
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NZ1 and NZ2
Parameters NZ1 and NZ2 are used for er-
ror checking.

NZ1 is used for error checking during
hunting and is the number of contiguous
samples of NC1 codewords without a
codeword sample error event that must
be recorded before the control channel
being sampled can be confirmed.

NZ2 is used for error checking during
continuous monitoring of a confirmed
control channel. Once an error has been
detected, NZ2 is the number of further
contiguous samples of NC2 codewords
each with a codeword sample error event
that must be recorded before the radio
can reject the control channe] on the
grounds of unacceptable codeword error
rate.

Each field should be set to a value from 1
to 255.

TS

Parameter TS is used by the radio when
searching for a control channel on a time-
shared system. The radio must remain on
each channel long enough to receive at
least one complete burst from each site
using the channel and so the value of TS
must be set high enough to allow this.

Enter a value from 1 to 10 seconds.

NC and NX

The combination of parameters NC and
NX set the error threshold at which the
control channel performance is consid-
ered inadequate. Separate values of NC
and NX are set for use during hunting
(NC1 and NX1) and during continuous
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monitoring of a confirmed control chan-
nel (NC2 and NX2).

Parameters NC1 and NC2 are the
number of contiguous positions in which
codewords are expected that will be mon-
itored in each codeword.

Parameters NX1 and NX2 are the
number of errored codewords that must
be exceeded in the count of the respective
NC codewords before the sample of NC
codewords is considered an error event.

For NC1 and NC2, set a value from 1 to
255 for both continuous and time-shared
channels.

For NX1, set a value from 0 to the value of
the corresponding NC1 parameter for
continuous and time-shared channels.

For NX2, set a value from 0 to the value of
the corresponding NC2 parameter for
continuous and time-shared channels.

NV

Parameter NV sets the number of consec-
utive CCSCs (codewords) with the same
value of SYS field that must be received
before the radio will attempt to verify
that value.

Enter a value from 1 to 16 for both contin-
uous and time-shared channels.

Background Search Param-
eters

The background search sequence is a
method prescribed in MPT 1343 for
monitoring other control channels and
migrating to a superior channel when one
is found.
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The background search is performed by
periodically leaving the current control
channel and sampling other control
channels. What channels are sampled is
defined in the Normal Hunt Channels
array (Hunting Parameters screen). If a
channel s consistently found for a certain

number of consecutive samples to be pre-

ferred (according to the NDD preference
data defined in the Acquisition Data
screen) or stronger than the current con-
trol channel by a certain margin, the ra-
dio will perform a preferential sampled
hunt to acquire the new control channel.

The fields listed under Background
Search Sequence Parameters set pa-
rameters the radio uses during back-
ground searches. The Background
Search Sequence field in the Hunting
Parameters screen must be set to ‘Ena-
bled’ for these parameters to have effect.

TL, TH and NS

Parameter TL sets the minimum interval
between successive departures from the
confirmed control channel. Set a value

from 10 to 320 seconds in steps of 10 sec-

onds.

Parameter TH sets the amount of time the
radio spends sampling other control
channels. Set a value from 1 to 100 slots
in steps of 1 slot.

If the value of TL is low and/or the value
of TH is high, new control channels will
be identified more rapidly; however, be-

cause the radio will spend less time listen-

ing to the confirmed control channel, it is
more likely that important messages will
be missed.

a4

Parameter NS sets the number of consec-
utive samples of a channel that must be
taken before it is identified as a candidate
for acquisition as a control channel.

Set a value from 1 to 10 in steps of 1.

The lower the value of NS, the fewer the
samples that need to be taken and so the
more rapidly a new control channel will
be identified. However, the identification
will be less accurate than if NS is set high-
er. Setting NS higher will mean that iden-
tifying a new control channel will take
longer, but identification will be more ac-
curate since the radio will tend to ignore
temporary fading effects.

LM1, LM2 and LM3

Parameters LM1, LM2 and LM3 set Jevel
margins used during preferential hunts.
These values are network dependent.

LM1 sets how much stronger the signal
on a sampled control channel must be
than the current control channel for it to
be considered during a background
search sequence when neither channel is
preferred.

LM2 sets how much stronger the signal
on a sampled control channel must be
than the current control channel for it to
be considered during a background
search sequence when both channels
have equal preference.

For both LM1 and LM2, enter the value
assigned by your network operator,
which will be from 3 to 40 dB in steps of 1
dB. Note that parameter LM2 is ignored
during hunts when the field Nokia TS
Channel Support (Hunting Parame-
ters screen) is set to ‘Enabled’.
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Parameter LM3 sets how much stronger
the signal on a sampled control channel
must be than the squelch threshold (L0)
for it to be considered during a back-
ground search sequence when the chan-
nelis not preferred at all.

For LM3, enter the value assigned by
your network operator, which will be
from 0 to 40 dB in steps of 1 dB.

Selecting a lower value for LM1 and/or
LM2 will ensure that the radio will always
migrate to a better control channel, even
ifitis only slightly better, and thus ensure
the best quality of speech during a call.
However, it will also result in increased
hunting activity, which will increase the
chance of missing important calls and
may load the trunking system unneces-
sarily with registration requests.

Selecting a higher value for LM1 and/or
LM2 will ensure that the radio will only
migrate to a new control channel if it is
significantly better than the confirmed
control channel. This will reduce the
amount of control channel swapping
which occurs and thus reduce the chance
of missing important calls and network
loading, but it might mean that the radio
provides a slightly reduced quality of
speech during a call. Raising LM 1 and/or
LM2 too high will prevent the radio from
swapping control channels entirely, as
the signal strength measurements are
most sensitive over a limited range.

Selecting a lower value for LM3 will en-
sure that the radio will always migrate to
a preferred control channel, even at the
expense of speech during a call. However,
it will also result in increased hunting ac-
tivity which will increase the chance of
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missing important calls and may load the
trunking system unnecessarily with regis-
tration requests.

Selecting a higher value of LM3 will en-
sure that the radio will only migrate to a
preferred control channel if the speech
quality is of some minimum standard.
This will reduce the amount of control
channel swapping that occurs and thus
reduce the chance of missing important
calls and network loading, but it might
mean that the radio does not acquire a
preferred control channel at the first op-
portunity. Raising LM3 too high will pre-
vent the radio from swapping control
channels entirely, as the signal strength
measurements are most sensitive over a
limited range.

Miscellaneous Signalling
Parameters

The fields listed under Signalling Pa-
rameters set various parameters used in
communication with the control chan-
nel.

Parameter NW sets the response delay, in
slots. Enter the value assigned by your
network operator, which will be from 1 to
15.

Parameter ND1 sets the number of dis-
connect messages sent by an individually
called radio. Enter the value assigned by
your network operator, which will be
from 1to 15.

Parameter ND2 sets the number of dis-
connect messages sent by a calling radio.
Enter the value assigned by your network
operator, which will be from 1 to 5.

Parameter NE sets the maximum number
of random access transmissions of RQE
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(emergency call request). Enter the value
assigned by your network operator,
which will be from 1 to 255.

Parameter NR sets the maximum
number of random access transmission
of RQS, RQD, RQX, RQT, RQR or RQQ
(non-emergency call requests). Enter the
value assigned by your network operator,
which will be from 1 to 255.

Parameter TC sets the random access
timeout. Enter the value assigned by your
network operator, which will be from 10
to 120 seconds in steps of 10 seconds.

Parameter TD sets the registration record
timeout used when Multiple Registra-
tion (Network ldentity screen) is set to
‘Enbaled’. Enter the value assigned by
your network operator, which will be
from 5 to 70 minutes in steps of 5 min-
utes.

Parameter TJ sets the further signalling
timeout. Enter the value assigned by your
network operator, which will be from 10
to 60 seconds in steps of 10 seconds.

Parameter TN sets the traffic channel in-
activity timeout. Enter the value assigned
by your network operator, which will be

from 1 to 10 seconds in steps of 1 second.

Parameter TT sets the maximum trans-
mit duration. Enter the value assigned by
your network operator, which will be
from 10 to 60 seconds in steps of 10 sec-
onds.

Parameter TA sets the timeout for the ra-

dio after receiving an AHY. Enter the val-

ue assigned by your network operator,
which will be from 1 to 255 seconds in
steps of 1 second.
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Parameter TB sets the time barred from
calling the same ident after ACK/ACKX/
ACKYV or any ident after a ACKT/ACKB.
Enter the value assigned by your network
operator, which will be from 1 to 255 sec-
onds in steps of 1 second.

Parameter TP sets the maximum interval
between periodic messages (within
speech limits) to be assumed at switch-
on. Enter the value assigned by your net-
work operator, which will be from 1 to
255 seconds in steps of 1 second.

Parameter TW sets the timeout for the ra-
dio waiting for a call. Enter the value as-
signed by your network operator, which
will be from 1 to 255 seconds in steps of 1
second.
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Trunked Channel Blocks Screen

Trunked channel blocks specify the oper-
ating frequencies of all channels on a net-
work. Trunked channel blocks are set up
in the Trunked Channel Blocks screen
(shown below).

Up to 20 blocks can be defined. Press F2
to insert a new channel block, or F3 to de-
lete the current channel block. At least
one channel block must be defined, and
so the last remaining channel block can-
not be deleted.

Seven fields must be set for each trunked
channel block.

Trunked Channel Blocks screen

Channel Start and Stop

The field Chan Start sets the first
number of each trunked channel block,
and Chan Stop sets the stop channel
number.

Enter a value from 1 to 1023 for Chan
Start, and a value greater than or equal to
the Chan Start value for Chan Stop.
Chan Stop cannot be set higher than
1023.

If it is not the first block defined, the
Chan Start value must be one greater
than the Chan Stop value for the previ-
ous block.

Print Help

Channal Start

Chan Chan Spacing Rx Freq

Start Stop kHz MHz

FPouer

Level

Iz | [to=s | [12.50 | [410.00000 | [400.00000 | Na,.,.m,l IHighI
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Your network operator will tell you what
values to set.

Channel Spacing

The field Channel Spacing kHz sets the
channel spacing (in kHz) for all channels
in the block and is the value that will be

used to calculate receive and transmit fre-

quencies from the values of Start Rx
Freq MHz and Start Tx Freq MHz.

Enter the value assigned by your network
operator, which will be a multiple of ei-
ther 5 kHz or 6.25 kHz.

Different blocks can have different chan-
nel spacing values.

Receive and Transmit
Frequencies

The field Start Rx Freq MHz sets the re-
ceive frequency for the first channel in the
block. The receive frequency for all other
channels in the block will be calculated
from this value using Channel Spacing
kHz.

The field Start Tx Freq MHz sets the
transmit frequency for the first channel
in the block. The transmit frequency for

all other channels in the block will be cal-

culated from this value using Channel
Spacing kHz.

For Start Rx Freq MHz and Start Tx
Freq MHz, enter the value assigned by
your network operator, which will be a
multiple of either 5 kHz or 6.25 kHz (the
same number must be used to calculate
both values) and will be within the radio’s
frequency band.

The first channel in a block always has the
lowest frequency, and the frequency

48

range for a block cannot overlap with any
other block’s frequencies.

Transmit Deviation

The field Tx Dev sets the transmitter de-
viation. It can be set to ‘“W’, ‘M’ or ‘N,
which corresponds to maximum devia-
tion settings of 5 kHz, 4 kHz and 2.5 kHz.
Set this field according to the system
channel spacing.

W 25 kHz channel spacing will normal-
ly require this field to be set to ‘W’.

W 20kHz channel spacing will normal-
ly require this field to be set to ‘M.

W 12.5kHz channel spacing will nor-
mally require this field to be set to
N

Channel spacing is indicated in the

number in the fifth position (second after

the hyphen) in the radio model number

(see the Specifications screen) or the
back of the radio.

B A1 indicates a wideband radio,
which can be programmed for opera-
tion on 20 and 25 kHz channels only.

B A ‘2 indicates a narrowband radio,
which can be programmed for opera-
tion on 12.5, 20 and 25 kHz chan-
nels.

For example, TOP-H2110, 2 = narrow-
band radio.

Transmit Power

The field Power Level sets the transmit
power level. Select ‘H’, ‘M, ‘L or ‘O’ for
high, medium, low or off.

For handportable radios, low is 1 watt,
medium is 2.5 watts and high is 5 watts
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(VHF) or 4 watts (UHF). For 800 MHz
handportable radios, only low (1 watt)
and high (3 watts) are available.

For mobile radios, lowis 5 watts, medium
is 15 watts and high is 25 watts.

Setting this field to ‘O’ disables transmit-
ting for this channel.
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Changing Fleet Settings

PART

This part describes how to change fleet settings.

Some of the fields in these screens require only low- or
medium-level password access. However, for access to
all fields in these screens, you will need high-level pass-
word access.

The Edit menu screens discussed in this part are:
B Fleet Identity

H LMS - Fleet Identity

Bl Fleet Parameters






Fleet Identity Screen

The fields in the Fleet Identity screen set
the Dialling Scheme the radio will use. If
Dialling Scheme is ‘MPT 1343, ‘ZVEL,
‘Number Presets’ or ‘Nokia ANN’, addi-
tional fleet information is also set in this
screen. If Dialling Scheme is ‘LMS Dial-
ling’ additional fleet information is set in
the LMS - Fleet Identity screen.

The Fleet Identity screen is shown below.

Dialling Scheme

The field Dialling Scheme describes the
‘dialled digit sequence’ categories used by
the radio forinterfleet and intrafleet calls.
It is system dependent and so should be

used only with compatible trunking sys-

Fleet Identity screen

tems. Tait Orca radios currently support
five options.

W ‘MPT 1343’ is suitable for all MPT
1343 networks.

W ZVElis suitable for Regionet 43 net-
works.

Bl ‘Number Presets’ is suitable for all
MPT 1343 networks. However, dial-
ling will be limited to the preset calls
programmed into the radio (Preset
Calls screen).

B ’'Nokia ANN’ is suitable for all Nokia
Actionet networks.

B ‘LMS Dialling’ is designed for Chi-
nese networks that utilise 5-digit in-

Print Help

Dialling Schene

Fleet Hunber Prefix

Fleet Individual Number

Highest Individual NHumber in Fleet

Fleet Group Nunher

Highest Group Number in Fleet

Prime Despatcher Number (’*0°)

Prime Emergency Address (’%*3")

ANN Numbering Model

[MPT 1343 |

|

|

]

Number or Prefix/Ident C(MPT1327)
] [ g R

B

ANN Fleet Structure
Start Stop FPP MEP

Prefix Prefix

B J =] [ J ]
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terfleet dialling. It is compatible only
with other LMS dialling trunking
systems.

Consult your network operator for the
appropriate Dialling Scheme.

For MPT 1343, Regionet 34, and Nokia
ANN networks, radio unit number and
group information are set in the Radio
Unit Identity screen. For LMS networks,
radio unit number and group informa-
tion are set in the LMS - Radio Unit Iden-
tity screen.

Radio Identity: Fleet
Two components of the full radio identity
are set in the Fleet Identity screen.

The full radio identity (MPT 1343 for-
mat) is made up of:

W prefix (the first three digits);

W fleet number (the next four digits);
and

W unit number (the last two or three
digits).

The field Fleet Number Prefix defines
the prefix and must be common to all ra-
dios in a fleet. Enter the value assigned by
your network operator, which will be
from 200 to 327.

The field Fleet Individual Number de-
fines the fleet number and must be com-
mon to all radios in a fleet. Enter the value
assigned by your network operator,
which will be from 2001 to 6050.

The radio unit number unique to each ra-
dioina fleet is assigned in the Radio Unit
Identity screen.
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Other Fleet Numbers

The field Highest Individual Number in
Fleet defines the highest individual
number that can be called by any unit
within a fleet.

Enter the value assigned by your network
operator, which in MPT 1343 networks
will be from 20 to 89 or 200 to 899, and in
Regionet 43 networks will be from 20 to
79 or 200 to 799.

The field Fleet Group Number is used
with Group Memberships (Radio Unit
Identity screen) to identify groups of ra-
dios in a network. Enter the value as-
signed by your network operator, which
will be from 2001 to 6050. If the user is
not allowed group calls, enter 0.

The field Highest Group Number in
Fleet defines the highest group number
that can be called by any unit within a
fleet. If the value of Fleet Group Number
is 0, then this field should also be set to 0.
Enter the value assigned by your network
operator, which in MPT 1343 will be
from 90 to 99 or 900 to 998, and in Regio-
net 43 will be from 90 to 99 or 900 to 999.

Fleet Call Numbers
Despatcher calls and emergency calls
should be common to all radios in a fleet.

The field Prime Despatcher Number
("*0") sets the number the unit will de-
fault to when a despatcher call (*0) is di-
alled without specifying a unit number.
Enter a valid unit number from within
the radio’s own fleet. For fleets that have
no despatcher, enter 0.

The field Prime Emergency Address is
the number the unit will default to when
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an emergency call (*9) is dialled without
specifying a unit number.

W Ifthe called unit is from within the
radio’s own fleet, enter the called
unit’s number in the Number field. If
50, the Prefix and Ident fields should
be set to 0.

W Ifthe called unit is in another fleet,
enter the number in MPT 1327 for-
mat in the Prefix and Ident fields. If
50, the Number field should be set to
0. Prefix should be a value from 0 to
127, and Ident should be a value
from 1 to 8100.

Consult your network operator if your
fleet is not MPT 1327 compliant.

Nokia ANN Numbering

Nokia ANN numbering is an alternative
to MPT numbering. ANN stands for Al-
gorithmic Network Numbering. The
main difference between the two num-
bering schemes is how fleets are divided.

The field ANN Numbering Model de-
fines the length of string to be used for in-
terfleet numbers when the Dialling
Scheme (Fleet Identity screen) is ‘Nokia
ANN’,

There are four options.
W If ‘Small’is selected then interfleet

numbers contain 5 digits. Fleets with
prefix 0 are accessible.

W If'Medium'’is selected then interfleet
numbers contain 6 digits. Fleets with
prefixes from 0 to 9 are accessible.

W If Large’is selected then interfleet
numbers contain 7 digits. Fleets with
prefixes from 0 to 99 are accessible.
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W If Extended Large’ is selected then
interfleet numbers contain either 7
or 8 digits. Fleets with prefixes from
0 to 127 are accessible, although in
some cases dialling may be abbrevi-
ated to 7 digits.

ANN Fleet Structure Array
Fleet structure is defined in the ANN
Fleet Structure array.

Upto 128 blocks can be defined. Press F2
to insert a new block, or F3 to delete the
current block. For each block, you must
set the Start Prefix, Stop Prefix, FPP
and MEP.

W Start Prefix is the first prefix of the
range to which the given values for
FPP and MEP apply. Enter a value
from 0 to 127.

W Stop Prefix is the last prefix of the
range to which the given values for
FPP and MEP apply. Enter a value
from 0 to 127 that is greater than or
equal to the value of the correspond-
ing Start Prefix.

W FPPisthe Fleet Partitioning Parame-
ter and sets the partition between
large and other fleets that are availa-
ble in the ident range of a prefix. FPP
gives the number of large fleets in a
prefix directly. Set the value assigned
by your network operator, which will
be from 1 to 10.

B MEP is the Miniaturisation Extent
Parameter and specifies how the re-
maining ident range of a prefix is di-
vided between small and mini fleets.
Set the value assigned by your net-
work operator, which will be from 1
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to 10 minus the value of FPP. For in-
stance, if FPP is 4, MEP should be
between 1 and 6.
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LMS - Fleet Identity Screen

The fields in the LMS - Fleet Identity
screen provide information about the
fleet to which a radio unit belongs when
Dialling Scheme (in the Fleet Identity
screen) is ‘LMS Dialling’. If Dialling
Scheme js ‘MPT 1343’, ZVEI', Number
Presets’ or ‘Nokia ANN’, these properties

should be set in the Fleet Identity screen.

Until Dialling Scheme (Fleet Identity
screen) s set to ‘LMS Dialling’, the LMS -
Fleet Identity screen will not be accessi-
ble.

The LMS - Fleet Identity screen is shown
below.

LMS - Fleet Identity screen

Radio Identity: Fleet

The field Fleet Number Prefix defines
the network across which all fleets have
been specified. Enter the value assigned
by your network operator, which will be
from 200 to 327.

The field Fleet Individual Number de-
fines the number that defines where in a
prefixa particular fleet falls. Enter the val-
ue assigned by your network operator,
which will be from 20 to 79, although not
all numbers in this range will be valid.
Whether a fleet number is valid depends
on the parameters set in the LMS Fleet
Structure array.

Print Help

Fleet Hunber Prefix

Fleet Individual Number

Highest Individual NHumber in Fleet

Highest Group Number in Fleet

Prime Despatcher Number (’*0°)

Prime Emergency Address (’%*3")

LME Fleet Structure
Start Stop 1 "n Y

Prefix Prefix

L T k=] [ I B ]

\

e

1
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Other Fleet Numbers

The fields Highest Individual Number
in Fleet and Highest Group Number in
Fleet cannot be selected, and their values
depend on fleet size, which is set in the
LMS Fleet Structure array.

The field Highest Individual Number in
Fleet defines the highest individual
number that can be called by any unit
within a fleet. Highest Individual
Number in Fleet will be one of the fol-
lowing values.

W 899 for Jarge fleets

W 553 for medium fleets
W 435 for small fleets

W 317 for tiny fleets.

The field Highest Group Number in
Fleet defines the highest group number
that can be called by any unit within a
fleet. Highest Group Number in Fleet
will be one of the following values.

W 999 for large fleets

B 950 for medium fleets
W 933 for small fleets

W 916 for tiny fleets.

Fleet Call Numbers
Despatcher calls and emergency calls

should be common to all radios in a fleet.

The field Prime Despatcher Number
(**0') sets the number the unit will de-
fault to when a despatcher call (*0) is di-
alled without specifying a unit number.
Enter a valid unit number from within
the radio’s own fleet. For fleets that have
no despatcher, enter 0.
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The field Prime Emergency Address
(**9") is the number the unit will default
to when an emergency call (*9) is dialled
without specifying a unit number. Enter a
valid unit number from within the radio’s
own fleet.

LMS Fleet Structure

The LMS Fleet Structure array defines
the LMS fleet structure that will be used
when the field Dialling Scheme (Fleet

Identity screen) is set to ‘LMS Dialling’.

LMS systems are divided up into large,
medium, small and tiny fleets.

W Large fleets have 699 units and 99
groups.

W Medium fleets have 354 units and 51
groups.

B Small fleets have 236 units and 34
groups.

W Tiny fleets have 118 units and 17
groups.

Upto 128 blocks can be defined. Press F2
to insert a new block, or F3 to delete the
current block. For each block, five fields

must be set.

Start Prefix is the first prefix of the range

to which the given values for 1’,’m’and °s’
apply. Enter a value from 0 to 127.

Stop Prefix is the last prefix of the range
to which the given values for I’,’m’and s’
apply. Enter a value from 0 to 127 that is
greater than or equal to the value of the

corresponding Start Prefix.

How many large, medium, small and tiny
fleets there are is determined by the val-
ues of the parameters |, mand s.
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W The value of | determines how many
large fleets there are.

B The value of m determines how
many medium fleets there are.

B The value of s determines how many
small fleets there are.

The number of tiny fleets is calculated
from the values of I, mand s.

Using these parameters, the network op-
erator can configure a system in which in-
terfleet and interprefix dialling are
possible from any radio in any other fleet
of any other prefix. Interfleet calls are
made by dialling a five-digit number, and
interprefix calls are made by dialling an
eight-digit number.

Each type of fleet is fixed in size, and so
the values of the fields in the LMS Fleet
Structure array will determine the values
of the following fields:

B Number Range for Individual Calls
(LMS - Radio Unit Identity screen);

H Number Range for Group Calls
(LMS - Radio Unit Identity screen);

W Highest Individual Number in
Fleet; and

W Highest Group Number in Fleet.
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Fleet Parameters Screen

The fields in the Fleet Parameters
screen define how calls are handled. The
Fleet Parameters screen is shown be-
low.

Full Off-Air Call Setup

Trunking systems can set up calls in two
ways. In some systems, it is possible for
the system to seek an acknowledgement
from the user of a called radio before set-
ting up a call. This is called full off-air call
setup.

In other systems, all calls are set up with-
out any acknowledgement from the
called user.

The field Full Off Air Call Set Up only

has an effect with systems where it is pos-

Fleet Parameters screen

sible to seek acknowledgement from the
called user before setting up the call. In
these systems, when the field Full Off Air
Call Set Up s set to ‘Allowed’, acknowl-
edgement will be sought from the called
party before a traffic channel will be allo-
cated for the call. If set to ‘Disallowed’, a
traffic channel will be allocated for the
call before the called radio has answered.

Call Duration
Four fields in the Fleet Parameters
screen relate to call duration.

Call Duration: Normal Calls
The field Default Call Time Limit sets
the maximum duration of a call. In MPT

Print Help

Full Off Air Call Set Up

Default Call Time Linmit

Default Emergency Call Tinme Linit

Call Timer Count-up

Ignore TSC Call Time Linit

Dynamic Group Insert

Stun and Reviuve

BEI

HiE ©E

Al lowed

seconds

seconds

Enabled
Enabled

Disabled
Disabled
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1327, this value can be overwritten by a
BCAST message from the system.

Enter a value as follows:
W enter 0 to set no limit on call time;

W enter avalue from 10 to 254 seconds
in steps of 1 seconds; or

B enter a value from 300 to 780 sec-
onds in steps of 60 seconds.

The system can raise or lower the call
time limit if necessary.

Call Duration: Emergency Calls

The field Default Emergency Call Time
Limit sets the maximum duration of an
emergency call. Enter a value as follows:

W enter 0 to set no limit on call time;

W enter avalue from 10 to 254 seconds
in steps of 1 seconds; or

W enter a value from 300 to 780 sec-
onds in steps of 60 seconds.

In MPT 1327, this limit cannot be over-
written by the system.

Call Duration Display
The field Call Timer Count-up does not
apply to Elan handportable radios.

During a call, the radio will display the
time remaining for the call (counting
down). When Call Timer Count-Upis set
to ‘Enabled’, the radio will instead count
up, starting from 0.

Network Control of Call Duration

If the field Ignore TSC Call Time Limit
is set to ‘Enabled’, call time limits set by
the system in BCAST SYSDEF messages
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will be disregarded. The radio will in-
stead always use the call limit set in the
Default Call Time Limit field.

Dynamic Group Insert

The Dynamic Group Insert feature al-
lows a system to add or delete a group us-
ing an AHYT signal on a control channel.

If the system offers this feature, setting
Dynamic Group Insert to ‘Enabled’ will
allow the first group defined in the Group
Memberships table (Radio Unit Identity
screen or LMS - Radio Unit Identity
screen) to be overwritten with the group
specified by a system AHYL.

The overwritten group is lost permanent-
ly unless another AHYT is received to re-
store it.

If Dynamic Group Insert is set to ‘Disa-
bled’, the first group in the Group Mem-
bership table will not be overwritten
when a system AHYT is received.

Stun and Revive

The Stun and Revive feature allows a sys-
tem to stun the radio using an AHYK sig-
nal on a contro) channel. While stunned,
the radio cannot make or receive calls,
but communication with the trunking
system controller is maintained. The ra-
dio will be inoperative until a corre-
sponding Revive’ command is received
via an AHYL addressed to the radjo over
the control channel.

If the system offers this feature, setting
Stun and Revive to ‘Enabled’ will allow a
system operator to stun the radio.
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Basic Radio Settings

PART

This part contains detailed information on changing
general information about the radio. The Edit menu
screens discussed in this part are:

Bl Specifications

H Radio Unit Identity

Hl LMS - Radio Unit Identity
Hl Power Save Features

Bl Acquisition Data






Specifications Screen

The Specifications screen shows basic
information about the radio such as the
radio model and the frequency band. The
Specifications screen is shown below.

Radio Model

The first four fields in the Specifications
screen show the radio model and infor-
mation related to it.

The first field, Radio Model, is automati-
cally read from the radio’s memory. The
next three fields display information con-
tained in the model number that is partic-
ularly relevant to the programming
system. Modifying any of these three
fields will amend the first field to reflect
these properties.

Specifications screen

You may wish to modify these fields to
read in a radio of a different type and use
the previous settings as a template for
programming radios of another variant,
e.g. a different frequency band.

You can find the model number on the
back of the radio. However, if the radio
has been reconfigured, the model
number on the back of the radio may not
match that read from the radio.

Handportable or Mobile

The second field shows whether the radio
being programmed is a mobile or hand-
portable radio. Select ‘Mobile’ or ‘Hand-
portable’ appropriate for the radio you
are programming. When this field is set

Print Help
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to ‘Mobile’, the third position in the Ra-
dio Model field will read ‘M’. When set to
‘Handportable’, the third position in the

Radio Model field will read ‘P’, e.g. TOP-

B1221, P = handportable radio.

This field must be set correctly as not all
features programmable using this pro-
gramming system are available for both
handportable and mobile radios.

Frequency Band

The third field sets the frequency band
the radio operates at and is indicated by
the fourth position (first after the hy-
phen) in the model number on the back
of the radio.

This letter indicates the frequency band
as follows:

136-174 MHz
174-225 MHz
220-270 MHz
270-310 MHz
290-340 MHz
336-400 MHz
400-470 MHz
450-530 MHz
806-870 MHz

T IZomEgNnw

e.g. TOP-B1211
B =136-174 MHz band (VHF)

Note: H band may be split into TOP-
HxxxL (Rx 400-450 MHz, Tx 400-440
MHz) and TOP-HxxxH (440-470 MHz).
TOP-HxxxL and TOP-HxxxH radios
should have the Frequency Band set to
The frequency band must be set correctly
in order to validate channel settings.
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Feature Set

The fourth field indicates the radio’s fea-
ture set, which is indicated by the sixth
position (third after the hyphen) of the
model number. ‘1’ indicates the Orca
Elan feature set, 2’ indicates the Orca Ex-
cel feature set, and ‘3’ indicates the Orca
Eclipse feature set. For example, for TOP-
B1211, 2 = Orca Excel feature set.

This field must be set correctly as not all
features programmable using this pro-
gramming system are available for all fea-
ture sets.

Radio Serial Number and ESN
The field Radio Serial Number is auto-
matically read from the radio’s memory.
It is used for identification only and al-
though you can select the field, changes
you make will have no effect. The Radio
Serial Number has no effect on the nor-
mal operation of the radio.

The ESN is the radio’s electronic serial
number. This number is automatically
read from the radio and consists of the
Manufacturer’s Code, Model Code and
Serial Number. You cannot change the
values of these fields.

Radio Display Messages
Two fields set how the radio displays
messages:

W Power-up Message; and
M Radio Message Language.

These fields do not apply to Elan hand-
portable radios and Elan and Excel mo-
bile radios.

The Power-up Message fields set the
message that is displayed when the radio
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is turned on. It can be up to 24 characters
chosen from:

AZ091#$% &> +-={} O]
<>:;?71,._""/space
Enter 12 characters in each box.
The field Radio Message Language sets
the language in which display messages

appear. Select ‘English’, ‘French’ or ‘Ger-
man’.
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Radio Unit Identity Screen

The fields in the Radio Unit Identity

screen define the radio’s identity on a par-

ticular network when the field Dialling
Scheme (in the Fleet Identity screen) is
set to ‘MPT 1343’, ‘ZVET’, ‘Number Pre-
sets’ or ‘Nokia ANN’. If Dialling Scheme
is ‘LMS Dialling’, the radio’s identity in-
formation is set in the LMS - Radio Unit
Identity screen.

The Radio Unit Identity screen is shown
below.

Radio Identity: MPT 1343
The full radio identity (MPT 1343 for-
mat) is made up of:

W prefix (the first three digits);

Radio Unit Identity screen

W fleet number (the next four digits);
and

W unit number (the last two or three
digits).

The field Radio Unit Number defines the
unit number that uniquely identifies each
radio within its fleet when ‘MPT 1343,
‘ZVEI or ‘Number Presets’ are set for the
Dialling Scheme field in the Fleet Iden-
tity screen. The Radio Unit Number
should already be assigned by the net-
work operator as part of setting up the
system. Enter the number assigned by
your network operator.

If Dialling Scheme is ‘Nokia ANN’, the
radio’s identity should be defined in the
ANN Radio Unit ID field.

Print Help

Radio Unit Number

Max Humber of Group Addresses

Group HMenberships

=i
EE

Nunber or Prefixs/Ident (MPT1327 Format) ANN Group ID User Programmable

ANM Radio Unit ID |70020

0 [To J-[o o | Dunanic

- >
Mumber Range for Individual Calls ta

Number Range for Group Calls o ] to [0 ]
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If Dialling Scheme is ‘LMS Dialling’, the
radio’s identity should be defined in the
Radio Unit Number field of the LMS -
Radio Unit Identity screen.

The number entered in the Radio Unit
Number field is dependent on the High-
est Individual Number in Fleet field in
the Fleet Identity screen.

If Highest Individual Number in Fleet
has two digits, enter a value from 20 to
the Highest Individual Number in
Fleet.

If Highest Individual Number in Fleet
has three digits, enter a value from 200 to
the Highest Individual Number in
Fleet.

The other components of the full radio
identity are set in the Fleet Identity
screen.

Radio Identity: Nokia ANN

The field ANN Radio Unit ID defines the
unit number that uniquely identifies each
radio within its fleet when Dialling
Scheme (Fleet Identity screen) is ‘Nokia
ANN’. The ANN Radio Unit ID should al-
ready be assigned by the network opera-
tor as part of setting up the system. Enter
the number assigned by your network op-
erator.

Group Addresses

The field Max Number of Group Ad-
dresses shows the maximum number of
group addresses available and that can be
programmed in the Group Member-
ships array. Set a value from 1 to 32.

Copyright TEL 8/99 IPN: 439-51200-01

Group Memberships

The Group Memberships array defines
what groups the radio belongs to. A radio
can belong to up to 32 groups, depending
on the number indicated in the Max
Number of Group Addresses field.
Press F2 to add a new group address, or
F3 to delete the current group address.

How group addresses are entered de-
pends on the setting of the Dialling
Scheme field in the Fleet Identity
screen.

If the Dialling Scheme is ‘MPT1343’,
‘ZVEI or ‘Number Presets’, group ad-
dresses can be entered in MPT 1343 for-
mat (in the Number field) or in MPT
1327 format (in the Prefix and Ident
fields). Whichever format you choose,
the other fields must remain set to zero. If
the Dialling Scheme is ‘Nokia ANN’,
group addresses must be entered in the
ANN Group ID field.

MPT 1343 Format

The number entered in Number is de-
pendent on the Highest Group Number
in Fleet field in the Fleet Identity screen.

If Highest Group Number in Fleet has
two digits, enter a value from 90 to the
Highest Group Number in Fleet.

If Highest Group Number in Fleet has
three digits, enter a value from 900 to the
Highest Group Number in Fleet.

If the radio will not belong to any groups
orif the group address will be specified in
MPT 1327 format, enter 0 for Number.
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MPT 1327 Format

For Prefix, enter a number from 0 to 127.
For Ident, enter a number from 1 to 8100.
If the radio will not belong to any groups
or if the group address is specified in
MPT 1343 format, enter 0 in both Prefix
and Ident.

ANN Group ID
For ANN Group ID, enter a valid ANN
group identity.

User Programmable

The field User Programmable sets the
method by which the radio subscribes to
different groups. When a radio is sub-
scribed to a group, it will respond to all
calls made within that group.

The first group in the array will always be
set to ‘Dynamic’. This position is left free
to allow a network operator to subscribe
the radio to a group over the air using the
Dynamic Group Insert feature, which is
enabled in the Fleet Parameters screen.
Any group number programmed for this
first group will be overwritten should the
network operator subscribe the radio toa
group using the Dynamic Group Insert
feature, and so it is recommended that
the value of the other fields in the first
row should be Jeft at 0.

The other four options for User Pro-
grammable are ‘Permanent’, ‘Selecta-
ble’, ‘Scan’ and ‘Scan + Selectable’.

B When set for Permanent’, the radio
will always respond to calls intended
for the group.

Bl When set for ‘Selectable’, ‘Scan’ or
‘Scan + Selectable’, the user must se-
lect the group before the radio will

respond to calls for that group. How
the group is selected depends on the
setting of User Programmable.

To select a group set as ‘Selectable’, the
user switches to a position on the 16-way
selector that designates that group. The
group’s number should be programmed
for one of the preset calls in the Preset
Calls screen and given a Preset ID from 1
to 16. The radio will respond to calls for
that group as long as the 16-way selector
is on the designated position.

To select a group set as ‘Scan’, the user
switches to a position on the 16-way se-
lector that designates group scanning.
The string *** should be programmed
for one of the preset calls numbered 1 to
16, as for ‘Selectable’ groups. When the
corresponding position on the 16-way se-
lector is selected, the radio will respond
to calls from all groups designated ‘Scan’.
The radio will respond to those groups as
long as the 16-way selector is on the des-
ignated position.

To select a group designated ‘Scan + Se-
lectable’, the user either switches to the
position designated for the group or to

the position designated for group scan-
ning.

Number Ranges for Calls

The last set of fields in the Radio Unit
Identity screen define the range of num-
bers the radio can make individual and
groups calls to.

For Number Range for Individual
Calls, the range entered is dependent on
the Highest Individual Number in Fleet
field in the Fleet Identity screen.
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If Highest Individual Number in Fleet
has two digits, the Number Range for
Individual Calls can be anywhere from
20 to the Highest Individual Number in
Fleet.

If Highest Individual Number in Fleet
has three digits, the Number Range for
Individual Calls can be anywhere from

200 to the Highest Individual Number
in Fleet.

If you wish to prevent the radio from
making individual calls to other radios in
its fleet, enter 0 in both fields.

For Number Range for Group Calls, the
range entered is dependent on the High-
est Group Number in Fleet field in the
Fleet Identity screen.

W IfHighest Group Number in Fleet
has two digits, the Number Range
for Group Calls can be anywhere
from 90 to the Highest Group
Number in Fleet.

W IfHighest Group Number in Fleet
has three digits, the Number Range
for Group Calls can be anywhere
from 900 to the Highest Group
Number in Fleet.

If you wish to prevent the radio from
making group calls to other radios in its
fleet, enter 0 in both fields.

Copyright TEL 8/99 IPN: 439-51200-01

71



LMS - Radio Unit Identity Screen

The fields in the LMS - Radio Unit Iden-
tity screen define the radio’s identity on a
particular network when the field Dial-
ling Scheme (in the Fleet Identity
screen) is set to ‘TMS Dialling’. If Dialling
Scheme is set to ‘MPT 1343’, ‘ZVET,
‘Number Presets’ or ‘Nokia ANN’, the ra-
dio’s identity information is set in the Ra-
dio Unit Identity screen.

The LMS - Radio Unit Identity screen is
shown below.

Radio Identity: LMS Dialling

The field Radio Unit Number defines the
unit number that uniquely identifies each
radio within its fleet when ‘LMS Dialling’
is set for the Dialling Scheme field in the

LMS - Radio Unit Identity screen

Fleet Identity screen. The Radio Unit
Number should already be assigned by
the network operator as part of setting up
the system. Enter the value assigned by
your network operator, which will be in
the range specified by the Number
Range for Individual Calls fields.

Group Addresses

The field Max Number of Group Ad-
dresses shows the maximum number of
group addresses available and that can be
programmed in the Group Member-
ships array.

Set avalue from 1 to 32.

- -
Print Help
Radio Unit Humber =00
Max Humber of Group Addresses 22 ]
Group Menmberships
User Programmable
o Dunanic |
Number Range for Individual Calls to 317
Numbar Range for Group Calls to 916
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Group Memberships

The Group Memberships array defines
what groups the radio belongs to. A radio
can belong to up to 32 groups, depending
on the number indicated in the Max
Number of Group Addresses field.
Press F2 to add a new group address, or
F3 to delete the current group address.

For each group, enter the group number.
Ifthe groupisin a different fleet, enter the
full interfleet dialling number.

Valid group numbers are in the range
specified by the Number Range for
Group Calls fields.

User Programmable

The field User Programmable sets the
method by which the radio subscribes to
different groups. When a radio is sub-
scribed to a group, it will respond to all
calls made within that group.

The first group in the array will always be
set to ‘Dynamic’. This position is left free
to allow a network operator to subscribe
the radio to a group over the air using the
Dynamic Group Insert feature, which is
enabled in the Fleet Parameters screen.
Any group number programmed for this
first group will be overwritten should the
network operator subscribe the radio to a
group using the Dynamic Group Insert
feature, and so it is recommended that
the value of the other fields in the first
row should be left at 0.

The other four options for User Pro-
grammable are ‘Permanent’, ‘Selecta-
ble’, ‘Scan’ and ‘Scan + Selectable’.
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B When set for ‘Permanent’, the radio
will always respond to calls intended
for the group.

B When set for ‘Selectable’, ‘Scan’ or
‘Scan + Selectable’, the user must se-
lect the group before the radio will
respond to calls for that group. How
the group is selected depends on the
setting of User Programmable.

To select a group set as ‘Selectable’, the
user switches to a position on the 16-way
selector that designates that group. The
group’s number should be programmed
for one of the preset calls in the Preset
Calls screen and given a Preset ID from 1
to 16. The radio will respond to calls for
that group as long as the 16-way selector
is on the designated position.

To select a group set as ‘Scan’, the user
switches to a position on the 16-way se-
lector that designates group scanning.
The string *** should be programmed
for one of the preset calls numbered 1 to
16, as for ‘Selectable’ groups. When the
corresponding position on the 16-way se-
lector is selected, the radio will respond
to calls from all groups designated ‘Scan’.
The radio will respond to those groups as
long as the 16-way selector is on the des-
ignated position.

To select a group designated ‘Scan + Se-
lectable’, the user either switches to the
position designated for the group or to

the position designated for group scan-
ning.

Number Ranges for Calls

The fields Number Range for Individual
Calls and Number Range for Group
Calls cannot be selected, and their values
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depend on fleet size, which is set in the
LMS - Fleet Identity screen.

The possible ranges for Number Range
for Individual Calls are as follows.

200 to 899 for large fleets
200 to 553 for medium fleets
200 to 435 for small fleets
200 to 317 for tiny fleets.

The possible ranges for Number Range
for Group Calls are as follows.

900 to 999 for large fleets
900 to 950 for mediumffleets
900 to 933 for small fleets
900 to 916 for tiny fleets.
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Power Save Features Screen

Economy mode reduces the radio’s pow-
er consumption when it is idle. Economy
mode is set up in the Power Save Fea-
tures screen, which is shown below.
Handportable and mobile radios each
have different forms of economy mode.

Mobile Radios

Ifthe vehicle connections are present, the
radio will detect whether the vehicle’s ig-
nition is on or off and will then behave ac-
cording to the settings of Economy
Timeout With Ignition On and Economy
Timeout With Ignition Off. These fields
operate independently of each other and
it is not necessary to set both timers.

Power Save Features screen

When the field Economy Timeout With
Ignition On is set to ‘Enabled’, the radio
will enter economy mode when the vehi-
cle ignition is on and there has been no
activity on the radio for the time period
specified in this field. Set hours, minutes
and seconds from 10 seconds to 18 houxs.

When the field Economy Timeout With
Ignition Off is set to ‘Enabled’, the radio
will enter economy mode when the vehi-
cle ignition is off and there has been no
activity on the radio for the time period
specified in this field. Set hours, minutes
and seconds from 10 seconds to 18 hours.

Print Help

Mobile Radio Economy Setup:

Econony Tinmeout Hith Ignition On

Econony Tinmeout Hith

Handportable Radio Econony Setup!

Backlighting Tiner

Ignition Off

[prsbrea | |s]
CRNCENCES

L —
[ Inl el -
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Handportable Radios

The setting of one field in the Power
Save Features screen affects the power
consumption in handportable radios.

Battery life can be extended by reducing
the amount of time radio backlighting re-
mains active.

Backlighting can be activated by the press
of a function key (one of the function key
settings set to ‘Backlighting’ in the Key
Settings screen) or by the activation of
night operation mode. Night operation
mode can be activated from the user func-
tion menu of Eclipse handportable radios
(see Night Operation Backlighting Lev-
elin the User Selectable Parameters
screen) or by the press of a function key
(one of the function key settings set to
‘Night Use”).

The field Backlighting Timer sets the
amount of time backlighting will remain
on when either backlighting is activated
or when night operation mode is activat-
ed. Enter a value between 1 and 10 sec-
onds in steps of 1 second.

For ‘Backlighting’, the backlighting will
remain active for the duration of the
Backlighting Timer. For night operation
mode, backlighting will remain on for the
duration of the backlighting timer, which
will reset whenever a key is pressed or a
call iis received.

Handportable radios can also make use of
dynamic power control, which reduces
transmit power in high signal strength ar-
eas. Dynamic power control can be ena-
bledin the User Selectable Parameters
screen, and can also be assigned to a func-
tion key setting (Key Settings screen).
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Acquisition Data Screen

The arrays in the Acquisition Data
screen define data that is used when the
radio is attempting to acquire a control
channel. The Acquisition Data screen is
shown below.

Acquisition Authorisation
The fields in the Acquisition Authorisa-
tion array specify how the radio identifies

a control channel on which it can operate.

Up to eight definitions are permitted.
Press F2 to insert a new definition, or F3
to delete the current definition.

For each definition, you must specify a
Type and Code.

Acquisition Data screen

The field Type specifies the areas of the
trunking network in which the radio may
operate. Enter the value assigned by your
network operator, which will be ‘Full’,
‘Area’ or ‘Zone’.

The field Code sets the specific code for
acquisition authorisation. On some net-
works, this field is left blank. Possible en-
tries are constrained by the values of the
fields Area Field Length (LA) and Zone
Field Length (LZ) (see the Network
Identity screen).

If the field Network Type (Network
Identity screen) is set to ‘National’, enter
avalue from 0 to 511. If Network Type is

Print Help

Acquisition Authorisation MDD Preference Data
Tupe Code Field Length Priority Ualue
7
N E ] ] L] L]
Home Zone @]
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set to ‘Regional’, set a value from 0 to 15
for Code.

Network Dependent Data
(NDD)

NDD preference data is used to encour-
age the radio to acquire certain control
channels during a preferential hunt.

Up to four definitions are permitted in
the NDD Preference Data array. Press
F2 to insert a new definition, or F3 to de-
lete the current definition.

For each definition, you must specify
Field Length, Priority and Value.

The field Field Length specifies how
many bits of the SYS code are used to de-
termine the identity of the site to be allo-
cated a priority. The maximum number
is dependent on Network Type (Net-
work Identity screen).

If the field Network Type is set to ‘Na-
tional’, enter a value from 1 to 9 for Field
Length. If Network Type is set to ‘Re-
gional’, enter a value from 1 to 4 for Field
Length.

The field Priority specifies the priority of
the entry, from 1 (high) to 10.

The field Value specifies the decimal val-
ue of the binary bits derived from the SYS
code to determine the site to be given pri-
ority. Value must be storable in the

number of bits specified by Field Length.

Home Zone

The field Home Zone specifies the net-
work zone in which the radio is normally
working. The radio also uses Home Zone
to determine whether re-registration is
required on a network when registration

records for the network have only been
maintained on a temporary basis.

The maximum value of Home Zone de-
pends on the value of the field Zone Field
Length (LZ) (Network Identity screen).
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Special Features

PART

This part contains detailed information on setting up
special features such as DTMF, conventional channels
and 5 digit interfleet dialling. The Edit menu screens
discussed in this part are:

Il DTMF Parameters
Il Conventional Channels

Bl 5 Digit Interfleet Call Lookup Table






DTMF Parameters Screen

DTMEF (dual tone multiple frequency) is
the tone-based system used in the world’s
telephone networks. Options for DTMF
dialling are set in the DTMF Parameters
screen (shown below).

The fields in the DTMF Parameters
screen do not apply to Elan handportable
radios or to Elan and Excel mobile radios.

When the field Manual DTMF Dialling is
set to ‘Enabled’, DTMF calls can be made
from the numeric keypad. When the field
PTT as Shift Key is set to ‘Enabled’, the
PTT key can be used as a ‘shift’ key to ac-
cess the DTMF tones A to D. If tones A to
D are not required, PTT as Shift Key
should be set to ‘Disabled’.

DTMF Parameters screen

The field Transmit Key Up Delay sets a
delay for the start of tone transmissions
so that a repeater has time to stabilise.
Enter a value from 10 to 2550 ms in steps
of 10 ms.

The field Interdigit Tx Hold Time sets
the period the transmitter remains on be-
tween the encoding of each digit during
manual dialling, which provides a delay
for the user to dial the next digit without
transmission stopping and restarting.
Some systems require continuous trans-
mission between DTMF tones and there-
fore a long hold time. Enter a value
between 10 and 2550 ms, in steps of

10 ms.

Print Help

HManual DTMF Dialling

PTT as Ehift Key

Transmit Key Up Delay

Interdigit Tx Hold Tine

Mininun Tone Duration (0 - 92, A - D)

HMinimum Tone Duration (*,#)

Mininun Intertone Gap
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The fields Minimum Tone Duration (0-
9, A-D) and Minimum Tone Duration
(*, #) set the minimum amount of time
tones will be encoded. Enter a value from
10 to 1020 ms in steps of 10 ms.

The field Minimum Intertone Gap sets
the minimum amount of time between

encoded tones. Enter a value from 10 to
500 ms in steps of 10 ms.

82
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Conventional Channels Screen

A trunked radio can switch between
trunked and conventional modes. Up to
10 conventional channels can be defined.
These channels are set up in the Conven-
tional Channels screen (shown below).

Conventional Channel Settings
The setting of the field Tx Inhibit on
Busy limits the conditions under which
the radio will transmit when in conven-
tional mode.

W Select ‘None’ and there will be no
transmission inhibit of any kind.

W Select Busy’ to prevent the radio
from transmitting when there is ac-
tivity on the channel.

Conventional Channels screen

B Sclect ‘Mute’ to prevent the radio
from transmitting when there is
channel activity but the radio re-
mains quiet (i.e. receiving an invalid
signalling tone).

When the field Access Conventional
Channels is set to ‘Enabled’, the radio
can operate in conventional mode. You
cannot change this setting.

The field Reverse Tone Burst Duration
specifies how long a CTCSS reverse tone
burst will be transmitted. Reverse tone
burst transmission increases the speed of
receiver shutdown in some repeaters and
associated equipment. Set a value from 0
to 250 ms in steps of 1 ms.

Print Help

Access Conventional Channels Enabled |
Reverse Tone Burst Duration 130 ns
Access Rx Freq Tx Freaq Tx Pur CTCSS CTCSS/DCS
Humber MH=z MH=z Deu Lul R Tx Squelch

T C B Eopn|
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Setting Reverse Tone Burst Duration to
0 disables reverse tone burst transmis-
sion.

The recommended value is 130 ms,
which will work for all CTCSS tones be-
tween 67.0 and 250.3 Hz. Longer dura-
tions may be used for Jower CTCSS
frequencies and shorter durations for
higher CTCSS frequencies; however, it
should not be necessary to deviate from

130 ms unless your system has specific re-

quirements.

Conventional Channels Array
The conventional channels the radio can
access are defined in the Conventional
Channels array. Up to 10 conventjonal
channels can be defined. Press F2 to in-
sert anew conventional channel, or F3 to
delete the current conventional channel.

The field Access Number defines the
string that must be entered to change to
the conventional channel. Enter a value
from 101 to 110, or from 101 to 109 for
the ZVEI dialling scheme.

On Elan handportable radios, the user
cannot dial strings, and so the Access
Number should be entered as one of the
calls defined in the Preset Calls screen.
When the user changes to that preset
call’s position on the 16-way selector, the
conventional channel will automatically
be selected.

Receive and Transmit Frequencies
The fields Rx Freq MHz and Tx Freq
MHz set the conventional channel’s re-
ceive and transmit frequencies.

For each channel, a receive and transmit
frequency must be entered between the

84

radio’s upper and lower frequency limits.
These values are set in the Rx Freq MHz
and Tx Freq MHz fields.

The letter in the fourth position (first af-
ter the hyphen) in the radio model
number (see the Specifications screen or
the back of the radio) indicates the radio’s
frequency band as follows:

136-174 MHz
174-225 MHz
220-270 MHz
270-310 MHz
290-340 MHz
336-400 MHz
400-470 MHz
450-530 MHz
806-870 MHz

——m X o EgnN®

Enter a frequency within the designated
range that is a multiple of either 5 kHz or
6.25 kHz.

The transmit frequency for band J must
be between 806 and 870 MHz, and the re-
ceive frequency must be between 851 and
870 MHz.

Band Hmay be available as 400-440 MHz
(radio model numbers TOP-HxxxL) and
440-480 MHz (radio model numbers
TOP-HxxxH).

W For TOP-HxxxL radios, enter a re-
ceive frequency between 400 and 450
MHz.

B For TOP-HxxxH radios, enter a re-
ceive frequency between 440 and 480
MHz.

The programming system will not differ-
entjate between TOP-HxxxL and TOP-
HxxxH radios, and so you will need to en-
sure that you are programming the cor-
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rect frequency for receive and transmit
frequencies.

Transmit Deviation

The field Tx Dev sets the transmitter de-
viation. It can be set to ‘W’, ‘M’ or ‘N,
which corresponds to maximum devia-
tion settings of 5 kHz, 4 kHz and 2.5 kHz.
Set this field according to the system
channel spacing.

W 25 kHz channel spacing will normal-
ly require this field to be set to ‘W’.

B 20 kHz channel spacing will normal-
ly require this field to be set to ‘M.

W 12.5KkHz channel spacing will nor-
mally require this field to be set to
‘N

Channel spacing is indicated in the

number in the fifth position (second after

the hyphen) in the radio model number

(see the Specifications screen) or the

back of the radio.

B A1 indicates a wideband radio,
which can be programmed for opera-
tion on 20 and 25 kHz channels only.

B A ‘2 indicates a narrowband radio,
which can be programmed for opera-
tion on 12.5, 20 and 25 kHz chan-
nels.

For example, TOP-H2110, 2 = narrow-
band radio.

Power Level

The field Pwr Lvl sets the transmit power
level. Select ‘H’, ‘M, ‘L’ or ‘O’ for high,
medium, low or off.

For handportable radios, low is 1 watt,
medium is 2.5 watts and high is 5 watts
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(VHF) or 4 watts (UHF). For 800 MHz
handportable radios, only low (1 watt)
and high (3 watts) are available.

For mobile radios, low is 5 watts, medium
is 15 watts and high is 25 watts.

Setting this field to ‘O’ disables transmit-
ting for this channel.

Subaudible Signalling

Tait Orca trunked radios can be config-
ured to use subaudible signalling on con-
ventional channels. Note that although
trunked radjos can transmit DCS subau-
dible signals, they cannot decode DCS.

The CTCSS Rx field sets the receive sub-
audible coding the radio must receive be-
fore the activity will be regarded as valid

and the mute opened.

The CTCSS/DCS Tx field sets the trans-
mit subaudible coding that will accompa-
ny each transmission made on the
channel.

For CTCSS Rx, enter a valid CTCSS fre-
quency (e.g. 156.7) from “Appendix A:
Valid DCS and CTCSS Frequencies” on
page 105. Leave the CTCSS Rx field
blank if no subaudible signalling will be
used.

For CTCSS/DCS Tx, enter either a valid
CTCSS frequency (e.g. 156.7) or a valid
DCS code (e.g. 043). Leave CTCSS/DCS
Tx blank to indicate that no subaudible
signalling will be used.

Squelch

The field Squelch sets the squelch level to
control the muting of unwanted noise in
the absence of an on-channel signal.
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Setting this field to ‘Country’ (12 dB
SINAD) means the radio can be used
in areas where the signal may be
weak and where maximum range is
desirable.

Setting this field to ‘City’ (16 dB SI-
NAD) makes the radio less sensitive
to interference so that stronger sig-
nals will be required for the radio to
unmute.
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5 Digit Interfleet Call Lookup Table

Screen

The 5 Digit Interfleet Call Lookup Ta-
ble is used to define 5-digit access strings
that can be used to make interfleet calls.
The 5 Digit Interfleet Call Lookup Ta-
ble screen is shown below. This screen
only applies to fleets that use MPT num-
bering. If the network is not MPT 1343
compliant, consult the network operator.

Up to 20 lookup entries can be set. Press
F2 to add a new lookup entry, or F3 to de-
lete the current lookup entry.

At least one of the fields Interfleet Calls
or Interfleet Group Calls in the Call Op-
tions screen must be set to ‘Enabled’ be-
fore any lookup entries can be made.

5 Digit Interfleet Call Lookup Table screen

For each lookup entry, five fields must be
set.

The field Number Prefix sets the lookup
table number prefix.

In MPT 1343, the number prefix must be
from 200 to 327. If you do not know the
number prefix of the fleet to be called,
consult the network operator.

The field Fleet Number sets the number
of the fleet that will be called.

In MPT 1343, the fleet number must be
from 2001 to 6050. If you do not know
the fleet number of the fleet to be called,
consult the network operator.

Print Help

Nunber Fleet Fleet

Prefix Nunber Tupe

Other Fleet Definitions (maximun of 20 definitions)

Highest Humber

5 Digit

in Fleet Access String

¥ R |

| L]

7
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The field Fleet Type sets the type of the
fleet that will be called and specifies
whether the call is an ‘Indjvidual’ or
‘Group’ call. The types are the same for
interfleet calls as they are for normal in-
fleet calls.

The field Highest Number in Fleet sets
the highest number in the fleet that will
be called.

InMPT 1343, if this lookup entry is being
defined for individual calls then the
number range is 20 to 89 or 200 to 899. If
the lookup entry is being defined for
group calls then the number range is 90
t0 99, or 900 to 998. If you are not sure of
the correct highest number for the fleet to
be called, consult the network operator.

The field Access String defines the five
digit, short form number the user will di-
al.

The first two digits of the Access String
must be unique and start with either a 2
ora 9. MPT 1343 recommends you use 2
as the first character of the Access String
for individual calls and 9 as the first char-
acter of the Access String for group calls.
This convention is not mandatory.

Accept the default number selected by
the software, or enter your own Access
String.
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Radio Interface Options

PART

This part contains detailed information on setting radio
interface options, such as what preset calls can be made
from the radio, what types of calls are allowed for the ra-
dio, function key settings and user menu options. The
Edit menu screens discussed in this part are:

Hl Preset Calls
Hl Call Options
Bl Key Settings

Il User Selectable Parameters






Preset Calls Screen

For Elan and Excel radios and Eclipse ra-
dios with Dialling Scheme set to a value
other than ‘Number Presets’, up to 20
preset calls can be defined, plus two func-
tion key preset calls. For Eclipse radios
with Dialling Scheme set to ‘Number
Presets’, up to 100 preset calls can be de-
fined, plus two function key preset calls.
These calls are set up in the Preset Calls
screen.

The Preset Calls screen is shown below.

Preset Calls List

The preset calls list defines the preset
calls the radio can make. Press F2 to in-
sert a new preset call, or F3 to delete the
current preset call.

Preset Calls screen

For each preset call, you must define the
Preset ID, Label and Call String.

The field Preset ID sets the number of
the preset call. For Elan and Excel radios
and Eclipse radios with Dialling Scheme
set to a value other than ‘Number Pre-
sets’, the number must be between 0 and
19. For Eclipse radios with Dialling
Scheme set to ‘Number Presets’, the
number must be between 0 and 99. En-
tries need not be numbered sequentially.

On Elan and Excel handportable radios,
preset calls numbered 1 to 16 will be as-
signed to the corresponding position on
the 16-way selector.

Print Help

Preset ID Label

Call String

o T [

Function Key Preset Call 1 [NONE

Function Keu Preset Call 2 [NONE
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The field Label does not apply to Flan
handportable radios. Label sets an alpha-
numeric label for the preset call. Each la-
bel must be unique. Enter a name of up to
8 characters from:

AZ091#$% &  +-={}()[]
<>:;?1,. "' /space

The field Call String sets the string that is
dialled when the preset call is selected.
Enter any valid dialling sequence using
the characters: 0-9 * #

What strings are valid depends on how
the trunking system is configured. Con-
sult your network operator, and see “Se-
lecting Groups” below and “Switching to
Conventional Channels” on page 93.

If conventjonal channels are avajlable on
the radio, you can also enter the Access
Number (Conventional Channels
screen) for a particular conventional
channel as the Call String. If a conven-
tional channel is assigned to one of the
16-way selector positions on Elan and Ex-
cel handportable radios, the convention-
al channel will automatically be selected
when the user changes to that position.

Call String cannot be left blank, nor can
it be set to another preset call Preset ID.

Function Key Preset Calls

Each radio can have two function key pre-
set calls that can then be assigned to a
function key setting.

For Function Key Preset Call 1 and
Function Key Preset Call 2, enter any
valid dialling sequence using the charac-
ters: 0-9 * #
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What strings are valid depends on how

the trunking system is configured. Con-
sult your network operator, and see “Se-
lecting Groups” below.

You can also enter a valid Preset ID from
the Preset Calls array, in which case the
corresponding Call String will be used

when the function key preset call is made.

In order to make use of these two preset
calls, they must be assigned to one of the
function key settings in the Key Settings
screen.

Selecting Groups

On Elan and Excel handportable radios,
groups set for ‘Selectable’, ‘Scan’ or ‘Scan
+ Selectable’ (Group Memberships table
in the Radio Unit Identity screen or the
LMS - Radio Unit Identity screen) can be
assigned to positions on the 16-way selec-
tor by setting them up as preset calls
numbered 1 to 16.

For groups designated ‘Selectable’ or
‘Scan + Selectable’, the group’s number
can be entered for Call String. When the
user switches to the corresponding posi-
tion on the 16-way selector, the radio will
be subscribed to the group. The radio will
be unsubscribed when the user switches
to another position.

The sequence *** can be entered for Call
String. When the user switches to the
corresponding position on the 16-way se-
lector, the xadio will be subscribed to all
groups designated ‘Scan’ or ‘Scan + Se-
lectable’. The radio will automatically be
unsubscribed from those groups when
the user switches to another position.
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Switching to Conventional
Channels

On Flan and Excel handportable radios,
conventional channels can be assigned to
positions on the 16-way selector by set-
ting them up as preset calls numbered 1
to 16.

If conventional channels are available on
the radio, the Access Number (Conven-
tional Channels screen) for a particular
conventional channel can be entered for
Call String. When the user switches to
the corresponding position on the 16-
way selector, the conventional channel
will automatically be selected.
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Call Options Screen

The fields in the Call Options screen de-
termine what call types a radio unit is per-
mitted to make and how they are made.

The Call Options screen is shown below.

Call Types
A trunking system can be set up to make

many different types of calls. These in-
clude:

H PABXcalls;

PSTN calls;
interfleet calls;
interfleet group calls;
ALLI calls;

Call Options screen

B network operator service calls;
W direct despatcher calls; and
W status calls.

These call types are enabled or disabled
in the Call Options screen.

Note that even though a particular call
type is enabled, the network itself can re-
strict the types of calls a radio unit can
make.

PABX Calls

A trunking system can be set up to make
calls to a private automatic branch ex-
change (PABX).

- -
Print Help

PABX Calls Disabled
Interfleet Calls B
Interfleet Group Calls
Netuork Operator Service Calls ]
Direct Despatcher Calls E
Status Calls
fAbbreviated Dialling
Abbreviated Dialling Linit

Callback Facility E
Unanswered Call Tiner

Divert Own Calls B
pivert Third Partu Calls
Do Hot Disturb ]
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If your system supports this feature and
you wish the radio to be capable of mak-
ing PABX calls, set PABX Calls to ‘Ena-

bled’.

PSTN Calls

A trunking system can be set up to make
calls to the public switched telephone
network (PSTN).

If your system supports this feature and
you wish the radio to be capable of mak-
ing PSTN calls, set PSTN Calls to ‘Ena-

bled’.

Interfleet Calls

When the field Interfleet Calls is set to
‘Enabled’, the radio can make calls to in-
dividual radios in other fleets.

Unless there is a specific reason to allow

this type of call, set this field to ‘Disabled’.

Interfleet Group Calls

When the field Interfleet Group Calls is
set to ‘Enabled’, the radio can make calls
to groups of radios in other fleets.

Unless there is a specific reason to allow

this type of call, set this field to ‘Disabled’.

ALLI Calls

When the field ALLI Calls is set to ‘Ena-
bled’, the radio can make calls to all
idents (ALLI).

High level password access is required to
change the value of this field. This facility
is normally used only by network techni-
cians and so this field should be set to
‘Disabled’ for most radios in a fleet. Do
not set this field to ‘Enabled’ unless au-
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thorised to do so by the network opera-
tor.

Network Operator Service Calls
When the field Network Operator Serv-
ice Calls is set to ‘Enabled’, the radio can
make a service call to the network opera-
tor.

This facility may be set up to aid in the re-
porting of, for example, faults.

High level password access is required to
change the value of this field.

Direct Despatcher Calls

When the field Direct Despatcher Calls
is set to ‘Disabled’, the radio cannot make
normal speech calls to the despatcher.

The despatcher’s number is defined in
the Prime Despatcher Number field
(Fleet Identity screen). Users can still en-
ter and leave the despatcher’s queue (if
available) using the dial strings *0# and
#0#.

Status Calls
When the field Status Calls is set to ‘En-
abled’, the user can send status calls.

When this field is set to ‘Disabled’, the
user will be able to dial status strings, but
the status message will not be sent.

Abbreviated Dialling for PSTN
Calls

The trunking system can be configured so
that radios on the system can make a call
to the PSTN without dialling the full
number.
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Set Abbreviated Dialling to ‘Enabled’ to
allow the radio to make use of this fea-
ture.

If Abbreviated Dialling is set to ‘Ena-
bled’, you should also set the Abbreviat-
ed Dialling Limit, which sets the number
of different abbreviated dialled calls a ra-
dio can make.

Tait Orca radios can support up to 50 ab-

breviated dialling calls, although the
number the trunking system supports
may be lower. Consult your network op-

erator to determine how many abbreviat-

ed dialling calls are available.

Missed Calls

The remaining fields in the Call Options
screen set properties for calls that are not
answered.

The field Callback Facility applies only
to Excel and Eclipse radios. When Call-
back Facility is set to ‘Enabled’, the
number of the caller will be displayed
when a call is received. If the user does
not wish to accept the call at that time, a
press of the clear key will clear down the
call and store the number in the call
queue so the user can call back later. If
Call Queuing is set to ‘Disabled’, that
number is the only number that will be
queued, and will be overwritten by future
calls.

The field Call Queuing sets a queue to
hold unanswered calls, automatically
queued calls and status calls. Full call
queuing is available on Excel and Eclipse
radios, and Elan radios can have unan-
swered calls queued.

When Call Queuing is set to ‘Full’, all
calls will be queued; this setting is not
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available for Elan radios. When set to
‘Unanswered’, only unanswered calls and
status calls will be queued, except on Elan
radios, where only unanswered calls will
be queued. When set to ‘Disabled’, only a
single unanswered call will be queued.

The field Unanswered Call Timer sets
how long an unanswered call alert will
persist. Set a value from 0 to 255 seconds
in steps of 1 second. If Unanswered Call
Timer is set to 0, the radio will ring until
the call is answered or is cleared down.

When the field Divert Own Calls is set to
‘Enabled’, the user can set the radio to di-
vert incoming calls to another destina-
tion.

When the field Divert Third Party Calls
is set to ‘Enabled’, the user can divert an-
other radio’s incoming calls to another
destination.

When the field Do Not Disturb is set to
‘Enabled’, the user can set the radio to ig-
nore incoming calls while still allowing
outgoing calls to be made as usual.

When Do Not Disturb is set to ‘Disabled’,
the radio will always receive calls as long
as it is switched on and in range of the
network. These calls may be accepted or
queued.
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Key Settings Screen

Function key and keypad settings, auxil-
iary settings and handset mode settings
are made in the Key Settings screen,
which is shown below.

Function Key Settings

There are two function keys on each ra-
dio, and a function can be assigned to a
short or long press of each key. Functions
can also be assigned to external function
keys on accessories such as the external
lapel microphone. The functions that can
be assigned to each of these function key
settings are described below.

Ifa particular feature is applicable only in
trunked mode or only in conventional

mode, the function key press will have no
effect while in the other operating mode.

W ‘Audible Indicators’ When the func-
tion key is pressed, audible indica-
tors will be toggled on and off.

B ‘Auxiliary’: An auxiliary hardware
device may be fitted inside the radio.
When the function key is pressed,
the auxiliary device will be turned on
oroff.

If Auxiliary Switch Action (in the
Key Settings screen) is set to ‘Mo-
mentary’, control of an auxiliary de-
vice cannot be assigned to a long
press of a function key, nor can any

other function.

Key Settings screen
- ry

Print Help

Function Keu 1 Short Press [pisabled

Function Keu 1 Long Press [pisablea

Function Key 2 Short Press [Pisabled

Function Keu 2 Lona Press [pisakled

External Function Keuy 1 [pisabled

External Function Key 2 [Pisabled

Auxiliary Active State E

Auxiliary Switch Action

Handset Mode Settings:

Uolume Increase Ouerrides Function |[Disabled

Uolume Decrease Ouverrides Function |[Disabled

Handset Inactivity Tiner

Keypad Lock Disables:

Function Keus
T
8 e B s

i

[® externs1 pTT

B Ext.

Hode Keus
[® volume keus

sec

Function Keus
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‘Dynamic Power Control’: Dynamic
power control optimises the radio’s
power use by reducing the transmit
power in high signal strength areas.
Pressing the function key toggles dy-
namic power control on and off.

‘Preset Call No. 1" and ‘Preset Call
No. 2: Pressing the function key
sends the assigned Function Key
Preset Call (as defined in the Preset
Calls screen).

On Flan handportable radios, if the
radiois in conventionalmode whena
trunking preset call is selected, the
call will proceed. Once the call is
complete and has been cleared
down, the radio will return to con-
ventional mode if a conventional
channel is selected on the 16-way se-
lector.

‘Site Select’: This feature is not avail-
able for Flan handportable radios.
Pressing the function key allows the
user to djal a control channel the ra-
dio must then attempt to register on
regardless of its suitability for acqui-
sition. Pressing the function key
again deactivates site select and so
the radio will resume hunting in the
noxmal manner.

The field Site Select (Hunting Pa-
rameters screen) must be set to ‘En-
abled’ before this feature can be
assigned to a function key setting.

‘Clear”: Pressing the function key

cancels the current operation. For ex-

ample, if a call setup is in progress, it
will be cancelled.

When programmed for ‘Clear’, the
function keypress will have no effect

while the radio is in conventional
mode.

‘Do Not Disturb’: This function only
operates in trunking mode.

When do not disturb is on, incoming
calls will be ignored while outgoing
calls can be made as usual. Pressing
the function key toggles the do not
disturb function on and off.

Do not distuxb is enabled in the Call
Options screen.

‘Backlighting’: This option can only
be set for Excel and Eclipse handport-
able radios.

When the function key is pressed,
backlighting will be activated. Back-
lighting will remain activated for the
duration of the Backlighting Timer
(Power Save Features screen). This
option can only be set for handporta-
ble radios.

‘Night Use’: This option can only be
set for Excel and Eclipse handporta-
ble radios.

When the function key is pressed,
night operation mode will be toggled
on and off. In night operation mode,
backlighting is turned on and re-
mains on for the duration of the
Backlighting Timer (set in the Pow-
er Save Features screen). Any activ-
ity on the radio, such as a keypress or
a call received will reset the back-
lighting timer. This option can only
be set for handportable radios.

‘Handset Mode’: Handportable radi-
os can be operated as a normal radio
or as a handset. When the function
key is pressed, the radio will toggle
handset mode on and off.
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B ‘Low Power’: When in low power
transmit mode, the radio will send
signals at low power, regardless of
the current channel’s power level set-
ting. Pressing the function key tog-
gles low power transmit mode on
and off.

B ‘Keypad Lock’: Keypad lock allows
the user to lock a set of keys so that
they cannot accidentally be activat-
ed. When the function key is pressed,
keypad lock will be activated. The
clear key (O€) must be pressed to
turn the keypad lock off. Keypad lock
is only available on Excel and Eclipse
handportable radios.

B Monitor”: This function only oper-
ates in conventional mode.
Pressing the function key toggles the
monitor facility on and off.

Auxiliary Settings

An auxiliary hardware device can be fit-
ted inside the radio. The field Auxiliary
Active State determines the active state
of the auxiliary control line. Select ‘High’
(+5 volts) or ‘Low’ (0 volts).

The field Auxiliary Switch Action sets
the operating mode of an auxiliary hard-
ware device, which can be controlled by
latching or momentary action. When set
to ‘Latching’, a press of the function key
will toggle between turning the hardware
device on and off. When set to ‘Momen-
tary’, the function key must be held down
for the device to operate and so a function
cannot be assigned to a long press of that
function key.
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Handset Mode

Volume Override

In handset mode, the function keys can
be programmed to act as volume control
keys, which is set up in the fields Volume
Increase Overrides Function and Vol-
ume Decrease Overrides Function. For
eachfield, choose the function key setting
that will be used for volume increase or
decrease. External function keys cannot
be set to control volume in handset
mode.

It is highly recommended that you pro-
gram different keypresses for controlling
volume in handset mode and turning
handset mode on and off.

These fields can only be set if one of the
function keys is programmed to operate
handset mode, which is only available on
handportable radios.

Handset Timer

The field Handset Inactivity Timer sets
the amount of time the radio will remain
in handset mode if no transmissions are
made. Set a value from 0 to 240 seconds
in steps of 1 second. If set to 0, the timer
will be disabled and the radio will remain
in handset mode until the user disables it.

Keypad Lock

The eight fields under the heading Key-
pad Lock Disables in the Key Settings
screen determine what keys are locked
when the keypad lock is activated. Key-
pad lock is only available on Excel and
Eclipse handportable radios.

Keys that can be disabled are:
W the PTT key
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function keys
numbers keys
<and > keys

an external PTT key, e.g. on a lapel
microphone

external function keys

mode keys, e.g. the alphanumeric en-

try mode key

volume keys.

For each field, select ‘Yes’ or ‘No’.

The power on/off (Eclipse handportable
radios only) and monitor keys can never
be locked.
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User Selectable Pa

rameters Screen

In the User Selectable Parameters
screen, the initial settings for various pa-
rameters are made and the options that
appear in the user function menu of
Eclipse handportable and mobile radios
are set. The User Selectable Parame-
ters screen is shown below.

For each parameter, Initial Setting is the
value the radio is set to when it is first pro-
grammed. On Eclipse radios, the value of
all parameters in this screen can be
changed by selecting them from the user
function menu. To place a feature in the
user function menu, select ‘Yes” in the In
User Menu? field.

User Selectable Parameters screen

For some parameters, the value can also
be changed by assigning the feature to a
function key setting (in the Key Settings
screen). Parameters that can be assigned
to a function key setting are:

B Audible Indicators

Auxiliary Control

Dynamic Power Control

Economy Mode Backlighting Level
Handset Mode Switch

Night Operation Backlighting

Low Power Transmit Control

Keypad Lock Control.

Print Help

USER SELECTABLE PARAMETERS

Keypress Confidence Tones
Tone Set

Audible Indicators Level

Audible Indicators

Auxiliaruy Control

Dunamic Power Control

Squelch fetting Control

Mohile Radioc Options
External Alert Function
External Mute
Normal Backlighting Level

Econony Mode Backlighting Lewvel

Handportable Radio Options
PTT Initiates a Call
Handset Mode Switch
NHight Operation Backlighting
Low Power Transmit Control

Keupad Lock Control

-
INITIAL SETTING IN USER MENU?

[Enablea \ [No |
=

[Fan H = E
[Enablea R CEERE|
[pisabled ] CEE R
= EH &
[Pisabled |

[Pisablea R

[Fu1t ]

[ore I5]

[pisabled ]

[ofF R

[orr ]
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If a parameter is not placed in the user
function menu (where applicable) or as-
signed to a function key, the value of that
parameter can only be changed by repro-
gramming the radio.

The parameters set in this screen can be
divided into three parts: those that apply
to both handportable and mobile radios,
those that apply only to mobile radios
and those that apply only to handporta-
ble radios.

Mobile and Handportable
Radios

The following parameters apply to both
handportable and mobile radios:

W Keypress Confidence Tones
Tone Set

Audible Indicators Level
Audible Indicators
Auxiliary Control

|
|
|
|
H Dynamic Power Control
|

Squelch Setting Control.

Audible Indicators

Four fields in the User Selectable Pa-
rameters screen set propetties of audible
indicators, which include keypress confi-
dence tones, received call signals, low
battery and high temperature warnings,
transmit timer and unanswered call sig-
nals, but not DTMF tones.

For the field Keypress Confidence
Tones, select ‘Enabled’ for tones, ‘Disa-
bled’ for no tones. The tone set used is
specified in the Tone Set field. Two tone
sets are available for Tait Orca radios. Se-

102

lect ‘Tait’ for the Tait tone set or ‘MPT
1343’ for the MPT tone set.

Keypress confidence tones will automati-
cally be disabled if the initial setting of
the Audible Indicators field is ‘Disabled’.

The field Audible Indicators Level sets
the volume of all audible alerts. Set Initial
Setting to ‘High’ or ‘Low’.

The setting of the field Audible Indica-
tors determines whether audible alerts
are enabled or disabled. Set the Initial
Setting to ‘Enabled’ to turn audible indi-
cators on.

If Audible Indicators is set to ‘Disabled’,
the settings of the fields Keypress Confi-
dence Tones and Audible Indicator
Level will have no effect.

Auxiliary Control

The Initial Setting for the Auxiliary Con-
trol field allows the user to control a hard-
ware device fitted inside the radio. If such
adeviceisfitted, this field should be set to
‘Enabled’. A function key can be assigned
to control an auxiliary device.

Dynamic Power Control

Dynamic power control optimises the ra-
dio’s power use by reducing the transmit
power in high signal strength areas. Set
the Initial Setting of the Dynamic Pow-
er Control field to ‘On’ to enable dynam-
ic power control.

Squelch Setting Control

Squelch Setting Control is only availa-
ble on Eclipse radios. Select “Yes”in the In
User Menu? field to place the option to
switch between city and country squelch
settings in the user function menu.
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Mobile Radios

The following parameters apply only to
mobile radios:

H External Alert Function

Bl External Mute

W Normal Backlighting Level
|

Economy Mode Backlighting
Level.

External Alert

On mobile radios, an external alert such
as a horn can be sounded when a call re-
mains unanswered if the appropriate
connections are installed. If you wish to
use such an external alert, set the Initial
Setting of External Alert Function to
‘Enabled’.

External Mute

An external device such as a car stereo
can be muted when the radio is transmit-
ting or receiving if the appropriate con-
nections are installed. To mute an
external device when the mobile radio is
transmitting or receiving, set the Initial
Setting of the External Mute field to ‘En-
abled’.

Mobile Radio Backlighting

Two fields affect mobile radio backlight-
ing. The Initial Setting of Normal Back-
lighting Level sets the level of
backlighting for mobile radios. Select
‘Full’ or ‘Dim’. The Initial Setting of
Economy Mode Backlighting Level sets
the level of backlighting for mobile radios
when operating in economy mode. Select
‘Dim’ or “Off’. A function key can be as-
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signed to turn mobile radio backlighting
on and off.

Handportable Radios
The following parameters apply only to
handportable radios:

PTT Initiates a Call
Handset Mode Switch
Night Operation Backlighting

Low Power Transmit Control

Keypad Lock Control.

PTT Initiates a Call

The Initial Setting of PTT Initiates a
Call determines whether a brief press of
the PTT initiates a call request. For Elan
handportable radios, this field should be
set to ‘Enabled’.

Handset Mode

Handportable radios can be operated asa
normal radio or as a handset. For Hand-
set Mode Switch, select ‘Yes’ in the In
User Menu? field to place the option to
turn handset mode on and offin the user
function menu of Eclipse handportable
radios. For all handportable radios, a
function key can be programmed to turn
handset mode on and off. Handset mode
is always deactivated when the radio is
powered up.

Handportable Radio Backlighting

The field Night Operation Backlighting
sets the level of night operation back-
lighting for handportable radios. Set the
Initial Setting to ‘On’ to enable night op-
eration backlighting. A function key can
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be programmed to turn night operation
backlighting on and off (‘Night Use”).

Low Power Transmit

When in low power transmit mode, the
radio will send signals at low power, re-
gardless of the preprogrammed level. For
the Initial Setting of the Low Power
Transmit Control field, select ‘On’ to
turn on low power transmit mode. A
function key can be programmed to turn
low power transmit on and off (Low
Power’).

Keypad Lock

For Keypad Lock Control, select ‘Yes’ in
the In User Menu? field to place the op-
tion to turn keypad lock on and off in the

user function menu of Eclipse handporta-

ble radios. A function key can be assigned
to turn keypad lock on and off for Excel
and Eclipse handportable radios.
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Appendix A: Valid DCS and CTCSS Fre-
quencies

This appendix lists the settings used for

CTCSS and DCS receive and transmit

tones. You can enter a valid CTCSS fre-
quency or a valid DCS code in an appro-

priate field. Leave the field blank to
indicate that no subaudible signalling
will be used on the channel.

Table 3: Standard DCS codes and their inverses

Three tables are provided:

W standard DCS codes and their invers-
es;

W commonly used DCS codes and their
inverses; and

W standard CTCSS tone frequencies.

Code Inv Code Inv Code Inv Code Inv Code Inv Code Inv
023 047 073 506 156 265 263 205 371 734 506 073
025 244 074 174 162 503 265 156 411 226 516 432
026 464 114 712 165 251 271 065 412 143 532 343
031 627 115 152 172 036 306 071 413 054 | 546 132
032 051 116 754 174 074 311 664 J 423 315 565 703
043 445 125 365 205 263 315 423 431 723 606 631
047 023 131 364 223 134 331 654 432 516 612 346
051 032 132 546 226 411 343 532 445 043 624 632
054 413 134 223 243 351 346 612 464 | 026 627 031
065 271 143 412 244 | 025 351 243 465 331

071 306 152 115 245 072 364 131 466 662

072 245 155 731 251 165 365 125 503 162
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Table 4: Commonly used DCS codes and their inverses

Code Inv Code Inv Code Inv Code Inv Code Inv Code Inv

017 050 122 225 246 523 274 145 446 255 462 252

036 172 145 274 252 462 325 526 452 053 523 246

050 017 212 356 255 446 332 455 454 266 526 325

053 452 225 122 266 454 356 212 455 332

Table 5: Standard CTCSS tone frequencies (Hz)

67.0 770 88.5 100.0 114.8 131.8 151.4 173.8 203.5 233.6

69.3 79.7 91.5 103.5 118.8 136.5 156.7 179.9 210.7 241.8

719 82.5 94.8 107.2 123.0 141.3 162.2 186.2 2181 250.3

74.4 85.4 97.4 110.9 127.3 146.2 167.9 192.8 225.7

106 8/99 IPN: 4395120001 Copyright TEL



Index

5 Digit Interfleet Call Lookup Table screen
87-88

A

Abbreviated Dialling Limit 95-96
Access Conventional Channels 83
Access Number 84, 92,93

Access String 88

Acquisition Authorisation array 77-78
Acquisition Data screen 36, 44, 77-78
Act On Vote Now 37

ALLI calls 94, 95

ANN Fleet Structure Array 55-56
ANN Group ID 69, 70

ANN Numbering Model 55

ANN Radio Unit ID 68, 69

Area Field Length (LA) 40, 77
Audible Indicators 102

Audible Indicators (function key setting) 97
Audible Indicators Level 102
Auxiliary (function key setting) 97
Auxiliary Active State 99

Auxiliary Control 102

auxiliary settings 99

Auxiliary Switch Action 97, 99

B

Background (Screen Colour Manager) 26
background search 35-36
Background Search Sequence 36, 44

Background Search Sequence Parameters
43-45
backlighting 76
Backlighting Timer 76
Backlighting (function key setting) 98
Backlighting Timer 98
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call duration 60-61

Call Options screen 87, 94-96, 98
Call Queuing 96

Call String 92, 93

Call Timer Count-up 61
Callback Facility 96

Chan Start 47-48

Chan Stop 47-48

Channel Display 37

channel spacing 48, 85

city squelch 86

Clear (function key setting) 98
Code 77

Colours option (Utility menu) 25, 25-26
COM ports 12, 13, 25
Comprehensive Hunt 36, 37, 38
Control Category 37

Control Channel Acquisition/Retention
42-43

conventional channels 93, 98

Conventional Channels screen 83-86, 92, 93
country squelch 86

CTCSS 105-106

CTCSS Rx 85

CTCSS tone frequencies 106

CTCSS/DCS Tx 85

D

Data File Extension (Defaults window) 26
Data File Path (Defaults window) 26
DCS 105-106

DCS codes and their inverses 105, 106
Default Call Time Limit 60-61

Default Emergency Call Time Limit 61
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Defaults option (Utility menu) 25, 25-27
Defaults window 12, 13, 22, 24

Dialling Scheme 53-54, 55, 57, 58, 68, 69, 91
direct despatcher calls 94, 95
Directories (File window) 22

display messages 66—67

Divert Own Calls 96

Divert Third Party Calls 96

Do Not Disturb 96

Do Not Disturb (function key setting) 98
Drives (File window) 22

DTMF Parameters screen 81-82
Dynamic Group Insert 61, 70, 73
Dynamic Power Control 102

Dynamic Power Control (function key setting)
98

E

economy mode 75-76
handportable radios 76
mobile radios 75

Economy Mode Backlighting Level 103
Economy Timeout With Ignition 75
Editmenu 21, 23, 25

External Alert 103

External Mute 103

F

Field Length 78

File menu 21, 22-23

File Name (File menu) 22, 23

File window 22, 23

Files (File window) 22

Fleet Group Number 54

Fleet Identity screen 53-56, 57, 58, 68, 69, 70,
72,95

Fleet Individual Number 54

Fleet Individual Number (LMS) 57

Fleet Number 87
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Fleet Number Prefix 54

Fleet Number Prefix (LMS) 57

Fleet Parameters screen 60-61, 70, 73
Fleet Type 88

FPP 55

frequency band 66, 84-85

Full Off Air Call Setup 60

Function Key Preset Call 92, 98
function key settings 97-99

G

group addresses 69

group addresses (LMS) 72

group membership 54, 61, 69-70, 92
Group Memberships array 69-70
Group Memberships array (LMS) 72, 73

H

handset mode 99, 103
Handset Inactivity Timer 99
Volume Override 99

Handset Mode (function key setting) 98
Handset Mode Switch 103

Help menu 21

Highest Group Number in Fleet 54, 69, 71

Highest Group Number in Fleet (LMS) 58,
59

Highest Individual Number in Fleet 54, 69,
70,71

Highest Individual Number in Fleet (LMS)
58,59

Highest Number in Fleet 88

Home Zone 78

Hunt Upon Expiry of NE or NR 36

Hunting Parameters screen 35-38, 44, 98

I

Ignore TSC Call Time Limit61
Interdigit Tx Hold Time 81
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interfleet calls 87, 94, 95
interfleet group calls 87, 94, 95

K

Key Settings screen 37, 92, 97-100
keypad lock 99-100, 104

Keypad Lock (function key setting) 99
keystrokes 19

L

Label (Preset Calls screen) 92

LM1,LM2, LM3 36, 44-45

LMS - Fleet Identity screen 53, 57-59

LMS - Radio Unit Identity screen 54, 59, 61,
68, 69, 72-74,92

LMS Dialling 69

LMS Fleet Structure array 57, 58-59

Load option (File menu) 22, 31

Low Power (function key setting) 99

Low Power Transmit Control 104

M

main window 20-21, 23
Manual DTMF Dialling 81
Max Number of Group Addresses 69, 73
Max Number of Group Addresses (LMS) 72
memory problems 14-15
MEP 55
Minimum Tone Duration 82
Minimum Tone Gap 82
Monitor (function key setting) 99
mouse
installing 11, 12

Multiple Registration 40-41, 46
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NC1,NC242,43

ND1, ND2 45

NDD preference data 36, 44

NDD Preference Data array 78

NE 45

Network Identity Code 39-40

Network Identity screen 39-41, 46, 77-78

network operator service calls 94, 95

Network Parameters screen 36, 41, 42-46

Network Type 39-40, 77-78

New option (File menu) 23

Night Operation Backlighting 103

Night Use (function key setting) 98

Nokia ANN 68, 69, 72

Nokia ANN numbering 55-56

Nokia TS Channel Support 35, 44

Non Applicable Channels array 36, 38

Normal Backlighting Level 103

Normal Hunt Channels array 36, 37-38, 44

NR 46

NS 36, 44

Number of Pressel On/Off Messages 40

Number Prefix 87

Number Range for Group Calls 71, 73

Number Range for Group Calls (LMS) 59,
73-74

Number Range for Individual Calls 70-71

Number Range for Individual Calls (LMS)
59,72, 73-74

NV 42,43

NW 45

NX1, NX2 42,43

NZ1,NZ2 42, 43

0)

online help 1, 21, 22
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P Radio menu 21, 23-25
Radio Message Language 67

PABX calls 94-95 Radio Model 65-66

Palette (Screen Colour Manager) 26 Radio Serial Number 66

Parallel Port (Defaults window) 25, 27 Radio Unit Identity screen 54, 61, 68-71, 72,
password 31, 33, 39,51 92

power level 48-49, 85 Radio Unit Number 68-69

Power Save Features screen 75-76, 98 Radio Unit Number (LMS) 72
Power-up Message 66—67 Read option (Radio menu) 23-24
Pre-Emphasis 40 receive frequency 48, 84-85

Preset Call (function key setting) 98 Reverse Tone Burst Duration 83-84
Preset Calls screen 53, 70, 73, 84, 91-92, 98

Preset ID 91, 92 S

pressel on/off messages 40

Prime Despatcher Number 54, 95 Save As.. option (File menu) 22, 23

Prime Despatcher Number (LMS) 58 Save option (File menu) 22-23

Prime Emergency Address 54-55 Screen Colour Manager 25-26

Prime Emergency Address (LMS) 58 Serial Port (Defaults window) 27
Print option (Utility menu) 25 serial port. See also COM ports
Printer Type (Defaults window) 25, 27 Signalling Parameters 45-46
Priority 78 SIL Field Length (LSIL) 40
Program option (Radio menu) 24, 32 Site Select 37, 98

programming sequence 31-32 Site Select (function key setting) 37, 98

Specifications screen 48, 65-67, 85

programming system
basic operations 19-27 Squelch 85-86
installing 12 Squelch Setting Control 102
starting 14-15 Start Prefix (ANN) 55
system requirements 11 Start Prefix (LMS) 58

PSTN calls 94, 95-96
PTT as Shift Key 81
PTT Initiates a Call 103
Pwr Lvl 48-49, 85

status calls 94, 95

Stop Prefix (ANN) 55

Stop Prefix (LMS) 58

Stun and Revive 61

subaudible signalling 85, 105-106
Q CTCSS reverse tone burst 83-84
SYNC Sequence 40

T

Quit menu 21, 27

R

) TA46

radio o TB 46
1

. connecting TC 46
radio keys 22
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TD 41,46

TH 36, 44

time-shared channels 35

TJ 46

TL 36, 44

TN 46

TP 46

transmit deviation 48, 85

transmit frequency 48, 84-85

Transmit Key Up Delay 81

transmit power 48—-49

troubleshooting
communicating with radio 24-25
memory problems 14-15

Trunked Channel Blocks screen 37, 47-49

TS 42,43

TT 46

TW 46

Tx Dev 48, 85

Tx Inhibit On Busy 83

Type 77

U

Unanswered Call Timer 96

User Programmable 70

User Programmable (LMS) 73

User Selectable Parameters screen 101-104
Utility menu 12, 13, 21, 25-27

\'

validation 22-23, 24, 32

Value 78

Value 78

Value of INFO in RQR 41

Volume Override (handset mode) 99

vote now 36-37
Act On Vote Now 37
Vote Now Advice Margin 36-37

Copyright TEL 8/99 IPN: 439-51200-01

Z

Zone Field Length (LZ) 40, 77,78
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Tait Electronics Limited
Software Licence Agreement

This legal document is an Agreement between
you (the “Licencee”) and Tait Electronics Lim-
ited (“Tait”). By opening this product package
and/or using the product you agree to be
bound by the terms of this Agreement. If you
do not agree to the terms of this Agreement,
do not open the product package and immedi-
ately return the unopened product package to
Tait. If you open the product package, that will
be deemed to be acceptance of the terms of
this licence agreement.

Licence

In consideration of the payment of the Licence
Fee, which forms part of the price you paid for
products you acquired from Tait or its subsidi-
ary or agent (the “products”) and our willing-
ness to be bound by the terms of this
agreement, Tait grants to you as Licencee the
non-exclusive right to use the copy of a Tait
software program included in the products
(the “Software”).

In particular, the Licencee may use the pro-
gram on a single machine and if the software
is supplied on a diskette, the licensee may:

(@) Copy the program into any machine read-
able or printed form for backup purposes
in support of your use of the program on
the single machine (certain programs,
however, may include mechanisms to
limit or inhibit copying; they are marked
“copy protected”), provided the copyright
notice must be reproduced and included
on any such copy of the Software.

(b) Merge it into another program for your
use on the single machine. (Any portion
of this program merged into another pro-
gram will continue to be subject to the
terms and conditions of this Agreement.)

The Licencee may not duplicate, modify,
reverse compile or reverse assemble the Soft-
ware in whole or part.
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Title to Software

This agreement does not constitute a contract
of sale in relation to the Software supplied to
the Licencee. Not withstanding the Licencee
may own the magnetic or other physical media
on which the Software was originally supplied,
or has subsequently been recorded or fixed, it
is a fundamental term of this Agreement that
at all times title and ownership of the Soft-
ware, whether on the original media or other-
wise, shall remain vested in Tait or third
parties who have granted licences to Tait.

Term and Termination

This Licence shall be effective until terminated
in accordance with the provisions of this
Agreement. The Licencee may terminate this
Licence at any time by destroying all copies of
the Software and associated written materials.
This Licence will be terminated automatically
and without notice from Tait in the event that
the Licencee fails to comply with any term or
condition of this Agreement. The Licencee
agrees to destroy all copies of the Software
and associated written materials in the event
of such termination.

Limited Warranty

The Software is supplied by Tait and accepted
by the Licencee “as is” without warranty of
any kind either expressed or implied, including
but not being limited to any implied warranties
as to merchantability or fitness for any particu-
lar purpose. The entire risk as to the quality
and performance of the Software vests in the
Licencee. Should the Software prove to be
defective, the Licencee (and not Licensor or
any subsidiary or agent of the Licensor) shall
assume the entire cost of all necessary servic-
ing, repair or correction. Tait does not warrant
that the functions contained in the Software
will meet the Licencee’s requirements or that
the operation of the Software will be uninter-
rupted or error free. However Tait warrants
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that the diskettes if any on which the Software
is supplied to the Licencee shall be free from
defects in material and workmanship under
normal use and service for a period of ninety
(90) days from the date of delivery to the
Licencee.

Exclusion of Liability
Tait's entire liability and the Licencee’s exclu-
sive remedy shall be:

1. The replacement of any diskette not
meeting Tait “limited warranty” and
which is returned to Tait or an authorised
agent or subsidiary of Tait with a copy of
the Licencee’s purchase receipt; or

2. If a diskette is supplied and if Tait is una-
ble to deliver a replacement diskette that
is free from defects in material or work-
manship, the Licencee may terminate
this Agreement by returning the Software
to Tait.

3. In no circumstances shall Tait be under
any liability to the Licencee, or any other
person whatsoever, for any direct or con-
sequential damage arising out of or in
connection with any use or inability of
using the Software.

4. Tait warrants the operation of the Soft-
ware only with the operating system for
which it was designed. Use of the Soft-
ware with an operating system other than
that for which it was designed may not be
supported by Tait, unless otherwise
expressly agreed by Tait.

General
The Licencee confirms that it shall comply
with the provisions of law in relation to the
Software.

Law and Jurisdiction

This Agreement shall be subject to and con-
strued in accordance with New Zealand law
and disputes between the parties concerning
the provisions hereof shall be determined by
the New Zealand Courts of Law. Provided how-
ever Tait may at its election bring proceedings
for breach of the terms hereof or for the
enforcement of any judgement in relation to a
breach of the terms hereof in any jurisdiction
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Tait considers fit for the purpose of ensuring
compliance with the terms hereof or obtaining
relief for breach of the terms hereof.

No Dealings

The Licencee may not sublicense, assign or
transfer the licence or the program except as
expressly provided in this Agreement. Any
attempt otherwise to sublicense, assign or
transfer any of the rights, duties or obligations
hereunder is void.

No Other Terms

The Licencee acknowledges that it has read
this agreement, understand it and agree to be
bound by its terms and conditions. The Licen-
cee further agrees that this is the complete
and exclusive statement of the agreement
between it and Tait in relation to the Software
which supersedes any proposal or prior agree-
ment, oral or written and any other communi-
cations between the Licencee and Tait relating
to the Software (LS-589).
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